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Introduction

About the Pretrial and Community Corrections Case Management
System User Guide

The Pretrial and Community Corrections Case Management System (PTCC) User Guide
provides information users will need when working with PTCC. The guide contains all the
information a new user will need to operate PTCC, and is guaranteed to be useful to experienced
users. The guide contains information about all PTCC modules, and the main windows in each
module. The Table of Contents and a comprehensive Index can assist with finding more
information on various topics.

How to Use this Manual

For a basic understanding of how the PTCC Case Management System works:

If you want to know… Read…

How PTCC works • Chapter 1: System Concepts
• Chapter 2: System Conventions

Common PTCC functions

• Chapter 3: Common Operations
• Chapter 4: Setup Module
• Chapter 11: Reports and Forms
• Appendix B: Sample Reports and Forms

Pretrial functions

• Chapter 5: Jail Admissions Module
• Chapter 6: Screening Module
• Chapter 7: Pretrial Placement Module
• Chapter 8: Pretrial Supervision Module

Community Corrections functions

• Chapter 9: Community Corrections Placement
Module

• Chapter 10: Community Corrections Supervision
Module

Administrative functions • Chapter 12: Administration

Specific tasks and functions

• Appendix A: Deleting a Case, Placement, and/or
Screening

• Table of Contents
• Glossary
• Index
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Symbols

Watch for the following symbols throughout the manual:

Symbol Description

!!! Important points that could affect your work.

Additional information to help you understand how the system works.

Things to do that can help your work.

Text Conventions

This manual uses the following text conventions:

• Arial 10 pt bold for text that appears in windows and buttons.
• Courier New 12 pt bold for text you type into a field.
• Times New Roman 12 pt bold italic for text to emphasize terms.
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Chapter 1: System Concepts
This chapter contains information that relates to the Pretrial and Community Corrections Case
Management System (PTCC) user interface.

PTCC Terms

The table below contains a list of screen terms and their definitions.

Term Definition
Application
Function Icon

A box labeled with a picture that executes a command when clicked.
Application function icons appear across the bottom section of the
window.

Barrel Button Buttons that allow rolling back and forth through numerical sequences.
Button An object labeled with a word that performs an action when clicked.
Check Box A box beside a field name that, when selected, activates the function

associated with the field name, such as View All Active Cases.
Dialog Box A window that provides specific system information, such as an error.
Ellipse Button A button, showing the ellipse (…) symbol, that provides specific

information about the sub-modules that must be filled out for each
process.

Field A section of a window or tab that contains one piece of information.
Magnifying Glass
Icon An icon that takes you to a search window.

Menu Bar A bar at the top of a window that contains system menus, such as File.
Module A segment of PTCC that carries out a specific function and combines

with other modules to make up the program. PTCC contains seven
modules: Setup, Jail Admissions, Screening, PT Placement, PT
Supervision, CC Placement, and CC Supervision.

Module Icon A box labeled with a picture indicating a module. Module icons appear
along the left side of the window.

Radio Button A button that enables a particular system function.
Screen The entire viewing area of the PC’s monitor. It may contain features of

Microsoft Windows®, as well as PTCC.
Sub-module A segment of a module that carries out a specific function and

combines with other sub-modules to make up a module. Each module
in PTCC contains several sub-modules.

Sub-Module
Button A button that takes you to the sub-module.

Summary List Box An area in a window or tab that contains data in text format.
Tab A title that opens a sub-window when clicked. Tab in this manual also

refers to the sub-window itself, such as the Demographics (contd.) tab.
Window The area of the screen containing the PTCC Case Management

System.
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Screen Samples

The screen samples below show some of the different PTCC terms.

WindowScreen

Tab

Field

Module Icons Ellipse
Button

Sub-Module Button

Application Function Icons

Check Box

Radio Button Summary List Box

Menu Bar

Data Fields

Data fields are spaces in the tabs that are designated to contain words or numbers recorded in
response to specific data items on the form. This manual includes explanations of unusual or
potentially confusing data fields; it does not contain information about data fields that are self-
explanatory.
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Terms and Definitions

The table below contains a list of terms that appear in the PTCC User Guide and their
definitions.

Term Definition
PTCC Pretrial and Community Corrections Case Management System
PT Pretrial
CC Community Corrections
GUI Graphical user interface is the collection of buttons and icons that let you use a

piece of software.
Defendant A person, or case, involved in the Screening process or supervised by Pretrial.
Offender A person, or case, supervised by Community Corrections.
Case A defendant or offender and their associated information.

PTCC Case Management System Overview

The Pretrial and Community Corrections Case Management System (PTCC) was developed to
satisfy the case management and reporting needs of statewide Pretrial and Community
Corrections localities and the Virginia Department of Criminal Services. PTCC provides
increased productivity and supervision at the local level, accurate reporting to DCJS and local
courts, and data consistency throughout the Commonwealth of Virginia.

PTCC contains seven modules with numerous sub-modules that are used to collect, display, and
report information about cases entered into the system. In addition, PTCC has a user-friendly,
intuitive, graphical user interface (GUI) for entering and displaying information. The table below
shows the modules that are used by Pretrial and those used by Community Corrections.

PTCC Modules Pretrial Community
Corrections

Setup Yes Yes
Jail Admissions Yes
Screening Yes
PT Placement Yes
CC Placement Yes
PT Supervision Yes
CC Supervision Yes
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Chapter 2: System Conventions
This chapter contains information about system conventions, such as PTCC icons, underlined
field names, and shortcuts.

PTCC Icons

The module icons on the left side of the PTCC window allow access to the PTCC modules and
the reports function; the application function icons at the bottom section of the window control
system functions.

Icon Name What it Does

Screening Opens the Screening module.

Setup Opens the Setup module.

PT Placement Opens the Pretrial Placement module.

PT Supervision Opens the Pretrial Supervision module.

CC Placement Opens the Community Corrections Placement module.

CC Supervision Opens the Community Corrections Supervision module.

Reports Opens the Reports function.

Exit Exits the PTCC program.

Previous Takes you to the previous window in the module.

Save Saves the information in the current window.

Undo Cancels the most recent changes.
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Icons, continued

New

Creates a new record in the sub-module you are working in.
For instance, if you are entering employment information and
want to enter another employment, click the Save icon to save
the current data, click the New icon to re-set the data fields,
enter the new information and click the Save icon.

Delete Deletes the current record in the sub-module or window you
are in.

Next Takes you to the next window in the module.

Underlined Field Names

Underlined field names indicate required fields. These fields must contain data before a record
can be saved. If you click the Save icon without entering data in a required field, a system error
message will prompt you to complete the field. The example below shows the required fields for
Interview/Pending on the Demographics tab.

Underlined and Italicized Field Names

Underlined and italicized field names require completion of at least one of the fields. For
instance, the example below shows the Arrest Date field and the Arrest Date Unknown check box.
One of these fields must be completed in order to save the record.
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Shortcuts

Like most Windows applications, PTCC has certain shortcuts that can enhance the use of the
application. The following are a few of the most useful shortcuts.

Alt + Letter
Whenever you see an underlined letter on an icon or menu item, you can activate that function by
pressing the Alt key and the underlined letter. For instance, pressing the Alt + S keys at the
same time activates the Save function. The sample below shows the Save icon with the S
underlined.

Date Fields
Date fields contain barrel buttons (up and down arrows) and a drop-down arrow.

Double-click directly in the field, and the system displays the current date. Otherwise, type the
date in the field, select it from the drop-down calendar, or use the barrel buttons to choose it.

Click the drop-down arrow, and the drop-down calendar appears.

Select the year and month before selecting the day. Use the slide bar at the bottom section of the
window to change the year and month. Click to the right or left of the slide button to select the
year, click the right or left arrow to select the month, and then select the day.

To enter the current date, double-click in the field; otherwise, it is easier and
faster to type the date in the field or select it from the calendar.
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Shortcuts, continued

Drop-Down Lists
Some fields have drop-down lists from which a selection can be made by pressing the drop-down
arrow. The example below shows the Hair Color drop-down list.

If the desired item is on the list, it is quicker to type the first letter in the field. The system fills in
the rest of the selection. In cases where the selections include several words that start with the
same letter, pressing the first letter a second time will get the second selection in alphabetical
order. For example, for hair color press B one time and Bald appears; press B again and Black
appears. The same functionality exists in other drop-down lists, such as: Eye Color, State, and
Marital Status.

Keystrokes
The table below contains a list of keystrokes and corresponding actions.

Key Stroke Example
Ctrl + C Copy selected text or graphic to the clipboard.
Ctrl + V Paste copied text from the clipboard.
Ctrl + X Cuts selected text or graphic and copies it to the clipboard.
Shift + Tab Opens the previous window.
Space Bar Toggles a checkbox between checked and unchecked.

Sorting Summary List Box Data
All summary list boxes can be sorted by clicking a column heading.

Click the heading you want to sort by and PTCC sorts the information in alphanumeric order,
depending on the selection. For instance, to sort a list of family members or references, click the
Name column heading and the system sorts the rows of information will in alphabetical order by
name.
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Navigating the System

Menu Bar
The menu bar contains seven menus that can be helpful when working with PTCC. The
following list shows the menu selections and the items they contain:

• File—Open Active Cases, New Case, Close, Close All, and Exit.

• Edit—Find and Find (Master-Name Index).

• Modules—Jail Admissions, Screening, Setup, PT Placement, PT Supervision, CC Placement,
and CC Supervision.

• Reports—Run Reports.

• Administration—Support Tables, Application Settings, and Staff. (Only super users can
access the Support Tables and Staff menu items.)

• Window—Cascade, and name of all open windows, if any.

• Help—Help Index and About PTCC.

!!! Menu availability and content may differ between sub-modules.

Each module contains sub-modules that capture or display related information.
Some sub-modules contain more than one tab, allowing for additional
information to be captured.
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System Reminders

The system provides various reminders and warnings about missing information or business rule
violations, when attempting to save data. The following are some of the common dialog boxes:

Invalid Data
This appears when attempting to save information in the Demographics tab before selecting one
of the following processes: Interview/Pending, Investigation, or Intake.

Missing Information
This appears when attempting to save a window without entering all required information.

Save Changes
This appears when attempting to leave a window without saving.
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System Reminders, continued

Undo Changes
This appears when the Undo icon is clicked.

Valid Placement
This appears when attempting to continue before entering a valid placement.

Pending/Closed Modification
This appears when attempting to modify placement-related information when the current status is
Pending or Closed.
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Chapter 3: Common Operations
This chapter contains information about operations that are common to both Pretrial and
Community Corrections users, such as logging in to the system and viewing cases.

Logging In

Follow the steps in the procedure below to log in to the PTCC Case Management System.

1. Click the PTCC icon, or

2. Click Start>Programs>PTCC>PTCC.

Result: The Pretrial and Community Corrections Login window appears.

Pretrial and Community Corrections Login window
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Logging In, continued

3. Type your user name in the User Name field and your password in the Password field.

User Name and Password are required for security and data integrity.

If a different user name appears in the User Name field, that person was the last
one to log in to PTCC from that computer. To change the name, highlight the
contents of the User Name field and type your user name.

4. Click OK.

Result: If you have active cases assigned to you, the Active Cases window appears with
your cases listed. If you do not have active cases assigned to you, a blank window
appears.

• From the Active Cases window, you can select the case you want to view or update
from your active cases, view all active cases and select a case to view or update, or
close the Active Cases window and get to the blank window.

• From the blank window, you can create a new case, search for an existing case, or
access any menu on the menu bar.

The Active Cases window does not show cases that have no placements, nor
those placements that have a status of Inactive, Pending, or Closed.



Chapter 3-Common Operations

October 2002 Virginia Department of Criminal Justice Services 3-3

Viewing Active Cases

Upon entering PTCC, if you have active cases assigned to you, the cases will appear in the
Active Cases window. The window contains summary information about all cases assigned to
you that currently have an active placement. The cases appear as line items in the window,
showing the following information: Last Name, First Name, Middle, Date of Birth, SSN, and
FBI/NCIC.

Active Cases window

To access the Active Cases window at any time click File>Open Active Cases on
the menu bar.
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Viewing Active Cases, continued
Viewing All Active Cases
To view all active cases, select the View All Active Cases check box on the Active Cases window.

Result: The Active Cases window appears showing all active cases in the database,
regardless of who they are assigned to.

Active Cases window

Selecting an Active Case
To select an active case from the list of active cases, double-click the case in the Active Cases
window, or highlight the case and click the OK button.

Result: The case appears in the Demographics tab of the Setup module.



Chapter 3-Common Operations

October 2002 Virginia Department of Criminal Justice Services 3-5

Searching for a Case

To search for a case that does not currently have any active placements, follow the steps in the
procedure below to access the Query-Setup window:

1. Click Edit>Find, or press the Control and F keys at the same time.

Result: The Query-Setup window appears.

Query-Setup window

2. Type the criteria by which you want to search for a case in the data fields at the top of the
window. Search using any of the following criteria: First Name, Middle Name, Last Name,
SSN (Social Security Number), DOB (date of birth), Race, and/or Sex.

The Query-Setup window does not allow searches by Case ID, but Case ID
appears as part of the line item in the Result list box.
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Searching a Case, continued

The name fields contain drop-down lists that can be used to modify the search using the
following selections: Begins, Ends, Equals, or Contains.

• Begins searches for a case whose name starts with the letters typed in that field.
• Ends searches for a case whose name ends with the letters typed in that field.
• Equals searches for a case whose name matches the letters typed in that field.
• Contains searches for a case whose name includes the letters, in the order they were

typed, in that field.

3. Click the Search button.

Result: The following screen shot shows the results of a search for cases whose last
names contain the letters fen.

Query-Setup window

4. Highlight the case you want to open in the Result list box and click the Open button, or
double-click the case.

Result: The case appears in the Demographics tab of the Setup module.

Anytime a case is opened or a new case is created, the case appears in the
Demographics tab in the Setup module.
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Creating a New Case

Follow the steps in the procedure below to create a new case:

1. Click File>New Case.

Result: A blank Demographics tab appears.

Demographics tab

2. Select one of the three process check boxes at the top of the window: Interview/Pending,
Investigation, or Intake. Each process activates a different set of required fields on this
screen, and throughout the Setup module. Click the Ellipses icon to see which sub-modules
are required for each process type. Once a process has been selected, type all available
information in the fields, ensuring that, at a minimum, all required fields are complete.

For more information about the processes, see Demographics Data Fields on
page 4-3.
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Existing Social Security Numbers

The system provides a warning when an existing Social Security Number (SSN) has been
entered.

If an existing SSN is entered for a new case, the following dialog box appears when the case is
saved:

Existing SSN dialog box

To replace the new record with the existing information, click the Yes button. To enter a
different SSN for the new record, click the No button and enter a different SSN, or all 9’s if the
case’s SSN is unknown.

If a case’s SSN is changed to an existing SSN, the following dialog box appears when the case is
saved:

Existing SSN dialog box

Click the OK button, and verify the SSN. If the correct SSN was entered, notify the Super User
(for more information about Super Users, see Staff Access Levels on page 12-18). To save the
case until the duplicate SSN issue is resolved, click the Undo icon.
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Searching for a VA Statute or Local Ordinance

When a charge is required, it must be identified as a Virginia Code or Local Ordinance. Click the
appropriate radio button, and search for the charge.

If the charge violates a VA Statute, go to the section Searching for a VA Statute; if the charge
violates a Local Ordinance, go to the section Searching for a Local Ordinance.

Searching for a VA Statute
To enter a specific Virginia statute, search for it by clicking the Magnifying Glass icon at the end
of the Statute data field. Follow the steps in the procedure below to search for statutes:

1. Click the Magnifying Glass icon at the end of the Statute data field.

Result: The Search Statutes window appears.

Search Statutes window
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Searching for a VA Statute or Local Ordinance, continued

Search for either a statute or a category, not both. Searching for both causes the
system to return the following message:

2. Statutes can be searched in either of two ways: by Statute number or by Category.

a. To search by Statute number:

 i. Click the Statute drop-down arrow.

 ii. Select a statute number from the drop-down list, and click the Search button.

Result: The related Statutes appear as line items in the Result list box.
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Searching for a VA Statute or Local Ordinance, continued

 iii. Select the desired statute from those listed in the Result list box, and click the
Open button.

Result: The statute number appears in the Statute field, and the system
automatically fills the Category, Descriptor, and Charge Class fields.

b. To search by Category:

 i. Click the Category drop-down arrow.

Result: The Category drop-down list appears.
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Searching for a VA Statute or Local Ordinance, continued

 ii. Select a category from the drop-down list, and click the Search button.

Result: The related Statutes appear as line items in the Result list box.

 iii. Select the desired statute from those listed in the Result list box, and click the
Open button.

Result: The statute number appears in the Statute field, and the system
automatically fills the Category, Descriptor, and Charge Class. fields.
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Searching for a VA Statute or Local Ordinance, continued
Searching for a Local Ordinance
To enter a specific Local Ordinance, search for it by clicking the Magnifying Glass icon at the
end of the Statute data field. Follow the steps in the procedure below to search for local
ordinances:

1. Click the Magnifying Glass icon at the end of the Statute data field.

Result: The Search Local Ordinances window appears.
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Searching for a VA Statute or Local Ordinance, continued

2. Click the Statute drop-down arrow.

Result: The Local Ordinances drop-down list appears.

3. Select the Local Ordinance from the drop-down list, and click the Search button.

Result: The related Local Ordinances appear as line items in the Result list box.
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Searching for a VA Statute or Local Ordinance, continued

4. Select the desired Local Ordinance from those listed, and click the Open button.

Result: The Local Ordinance appears in the Statute field, and the system automatically
fills the Descriptor and Charge Class. fields.
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Searching for Courts

To enter a specific court, search for it by clicking the Magnifying Glass icon at the end of the
Court data field. Follow the steps in the procedure below to search for a court:

1. Click the Magnifying Glass icon at the end of the Court data field.

Result: The Search Courts window appears.

Search Courts window

Searching by locality returns all courts serving the locality.

Searching by court returns all localities served by that court type (General
District, General District Criminal, General District Criminal & Traffic, General
District Traffic, or Juvenile & Domestic Relations).

It is recommended that you search for either a locality or a court type, not both.
Searching for both may return the No Matches Found error message if the wrong
combination is entered.
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Searching for Courts, continued

2. A Court can be searched in either of two ways: by Locality or by Court Type.

b. To search by Locality:

 i. Click the Locality drop-down arrow.

Result: The Locality drop-down list appears.

 ii. Select a locality from the drop-down list, and click the Search button.

Result: Matches for the Locality and any Court Type appear in the Result list box
in the Search Courts window.
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Searching for Courts, continued

 iii. Select the desired court from the Result list box, and click the Open button.

Result: The locality and court type appear in the Court field.

c. To search by Court Type:

 i. Click the Court Type drop-down arrow.

Result: The Court Type drop-down list appears.
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Searching for Courts, continued

 ii. Select a court type from the drop-down list, and click the Search button.

Result: Matches for all localities that have that court type appear in the Result
list box in the Search Courts window.

 iii. Select the desired locality from the Result list box, and click the Open button.

Result: The locality and court type appear in the Court field.
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Statewide Search for Defendants and Offenders

The Master-Name Index is a database that contains records for all cases in the state that have at
least one current and/or past PTCC placement. Use the Master-Name Index to search the
statewide database of defendants and offenders who have an active, inactive, or closed PTCC
placement in a locality in the state. For more information about a case identified in the Master-
Name Index, call the program listed in the Master-Name Index record for that case.

Using Edit>Find (Master-Name Index) to Locate a Defendant or Offender
Follow the procedure below to conduct a statewide search for a defendant or offender.

1. Click Edit on the PTCC menu bar, and click Find (Master-Name Index), or press the Ctrl and
I keys at the same time.

Result: The Query-Master Name Index window appears.
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2. Select the Radio button to search the desired program (Pretrial, Community Corrections, or
both).
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Statewide Search for Defendants and Offenders, continued

3. To search for a case, type the search criteria in the data fields at the top of the window.
Searches can be completed by First Name, Last Name, Current Status, SSN (Social Security
Number), DOB (date of birth), Locality, Race, and/or Sex.

The name fields contain drop-down lists that can be used to modify the search using the
following selections: Begins, Ends, Equals, or Contains.

• Begins searches for cases whose names start with the letters typed in that field.
• Ends searches for cases whose names end with the letters typed in that field.
• Equals searches for cases whose names match the letters typed in that field.
• Contains searches for cases whose names include the letters, in the order they were typed,

in that field.

4. Click the Search button and the cases that match the search criteria appear in the Result list
box. The Result list box shows the following information about each case: Last Name, First
Name, Middle Name, Suffix, Birthdate, SSN, Sex, Race, Case ID, Locality, No. PT Plcmts, PT
Status, PT Status Date, No. CC Plcmts, CC Status, CC Status Date, Program, SID, and FBI No..

5. If the specified case is found, call the locality where the case has a current or past PTCC
placement.
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Chapter 4: Setup Module
This chapter contains information about the Setup module. The module captures and displays
information in PTCC. When opening a new or existing case, PTCC opens to the Demographics
tab in Setup. Setup includes the following sub-modules:

• Demographics
• Aliases
• Residence
• Family/Reference
• Employment
• Other Income
• Education
• Military
• Substance Use
• Substance Treatment
• Health Issues
• Other Ed/Tx Programs
• Assessment Tests
• Criminal Events—accesses the following sub-modules:

Pending Charges
Outstanding Warrants
Prior Criminal Activity

Information in the Setup module is required by minimum standards as part of
program operations.
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Demographics

The Demographics sub-module captures and displays personal information about a case. The
sub-module consists of two tabs: Demographics and Demographics (contd.).

Demographics Tab
The Demographics tab allows for the addition, modification, or deletion (with limitations, see
Appendix A: Deleting a Case, Placement, and/or Screening on page A-1) of personal information
about a case. Data entry minimum requirements for this tab vary, depending on the process that
is being completed: Interview/Pending, Investigation, or Intake. One of the processes must be
selected in order to save the information. Once the process is selected, the system identifies the
minimum required fields by underlining the field names. When a new case is saved, the system
automatically assigns a case number, which appears in the bottom section left corner of the
PTCC window.

Demographics Tab

The Interview/Pending process is used when interviewing a defendant in
preparation for an investigation and to set up a placement in advance of an intake
(pending).

The Investigation process is used when completing a pretrial investigation.

The Intake process is used when performing a full intake.

Only users with Supervisor rights to PTCC can enter a Date Last Reviewed. For more
information about Supervisor rights, see Staff Access Levels on page 12-18.

Click the New icon to clear the data fields on both tabs and enter a new case.
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Demographics, continued
Demographics Data Fields
The following table lists the minimum required fields based on the process type selected in the
Demographics tab. The table shows the field names, whether they are required, and what should
be entered.

Interview/Pending Process
Requirements

Six fields are required when conducting an Interview, or
setting up a pending PT or CC Placement.

Field Required Entry
First Name Yes Type first name.
Last Name Yes Type last name.
SSN Yes Type Social Security Number. If unknown, use all 9’s.
DOB Yes Select date.
Race Yes Select from drop-down.
Sex Yes Select from drop-down.

Investigation Process
Requirements

All Interview requirements plus these three fields are
required for an Investigation.

Field Required Entry
Martial Status Yes Select from drop-down.
No. of Dependents Yes Type number of dependents.
No. Living w/
Defendant

Yes Type number of dependents living with the case.

Intake Process Requirements All Interview and Investigation requirements plus these
five fields are required for an Intake.

Field Required Entry
Primary Language Yes Select from drop-down.
Other Description No Type language.
English Literate Yes Select from drop-down.
Virginia SID No. Yes Type number; the system allows None.
FBI No. Yes Type number; the system allows None.
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Demographics, continued

Non-required fields These fields are not required, but are strongly
recommended.

Field Required Entry
Middle Name No Type middle name.
Suffix No Select from drop-down.
Maiden Name No Type maiden name.
Height (in) No Type height in inches.
Weight (lbs) No Type weight in pounds.
Eye Color No Select from drop-down.
Hair Color No Select from drop-down.
Interpreter Needed No Select from drop-down.
Age - System filled.
Local Tracking No. No Type local tracking number.
Date Last Reviewed No Select date.
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Demographics, continued
Demographics (contd.) Tab
The Demographics (contd.) tab is a continuation of the Demographics tab. It captures and
displays additional personal information about a case.

Demographics (contd.) tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields on both tabs and enter a new case.
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Demographics, continued
Entering SID Numbers
One SID (State Identification) number can be entered directly into the Virginia SID No. field.
Follow the steps in the procedures below to add, modify, or delete additional SID numbers:

1. Save the information on the current Demographics tab.

2. Click the Magnifying Glass icon beside the Virginia SID No. field.

Result: The Additional State Identification Numbers window appears.

If the SID Number field contains a SID Number, that number and any additional
SID numbers appear in the SID’s list box.

Adding a SID Number
To add a SID number, follow the steps in the procedure below:

1. Click the New button to clear the fields.

2. Type the SID number in the SID Number field.

3. Click the State drop-down arrow.

4. Select a state from the drop-down list.
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Demographics, continued

5. If this SID is the valid Virginia SID, select the Valid SID check box.

6. Click Save.

Result: The new SID number and related information appear in the list box. When the
Valid SID check box is activated, Yes appears in the summary list box under the Valid
Virginia SID column.

The SID marked as valid is the one that appears on the Demographics tab.

Modifying a SID Number
To modify a SID number:
• select a SID number in the list box
• make the changes in the data fields at the bottom section of the window, and
• click the Save button.

Deleting a SID Number
To delete a SID number:
• select a SID number record in the list box, and
• click the Delete button.
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Aliases

The Aliases sub-module captures and displays alias information for a case. The sub-module
contains one tab, Aliases. The tab contains a summary list box showing: First Name, Last Name,
Middle Name, SSN, and DOB. Select an alias record in the list box, and the details for that record
appear in the fields at the bottom section of the tab. Use the fields in this tab to add, modify, or
delete alias information.

Aliases tab

Select Yes from the Used During Arrest drop-down list, if the person used the alias at the time of
the arrest. Type comments about how and where the person used the alias during the arrest in the
How/Where Used data field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
alias.
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Residence

The Residence sub-module captures and displays information about the case’s current and past
addresses. The sub-module contains two tabs: Residence and Residence (contd.).

Residence Tab
The Residence tab contains a summary list box showing: Homeless, From, To, Address Type,
Address Line 1, Address Line 2, City, State, and ZIP. Select a residence record in the list box, and
the details for that record appear in the fields at the bottom section of the tab and on the
Residence (contd.) tab. Use the fields in this tab to add, modify, or delete residence information.

!!! The Investigation and Intake processes require entry of at least one address.

PTCC uses the last residence record entered as the current residence for
correspondence and in other instances when an address is needed.

Residence tab

Homeless, Fixed Address, Time In Area, and Time in State are case-specific fields rather than
residence-specific. When these fields change in one record, they automatically change in all
records.
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Residence, continued

If the physical address is the same as the mailing address, click both check boxes, enter the
physical address, and the mailing address will automatically be filled on the second tab.

If the physical address differs from the mailing address, click the physical address check box,
enter the physical address, and then enter the mailing address on the 2nd tab.

The mailing address, if entered, is used for all correspondence to the case. If
mailing address is not entered, the physical address will be used.

Click the New icon to clear the data fields on both tabs and enter another residence.

Residence (contd.) Tab
The Residence (contd.) tab is a continuation of the Residence tab. The tab captures and displays
additional information for the residence record.

Residence (contd.) tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields on both tabs and enter another residence.
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Family/Reference

The Family/Reference sub-module captures and displays information about a case’s family
members and references. The sub-module consists of one tab, Family/Reference. The tab contains
a summary list box showing: Name, Relationship, Address1, Address2, City, State, and Phone.
Select a family/reference record in the list box, and the details for that record appear in the fields
at the bottom section of the tab. Use the fields in this tab to add, modify, or delete
family/reference information.

When Family/Reference information is obtained, the following fields are
required for the selected process:
• Interview/Pending: Name.
• Investigation and Intake: Name, Relationship, Verified, and either City, State,

or Phone Number.

Family/Reference tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
family/reference record.
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Employment

The Employment sub-module captures and displays information about a case’s employment
history. The sub-module contains two tabs: Employment and Employment (contd.).

Employment Tab
The Employment tab contains a summary list box showing: Currently Employed, From, To,
Company, Supervisor, and Phone Number. Select an employment record in the list box, and the
details for that record appear in the fields at the bottom section of the tab and on the Employment
(contd.) tab. Use the fields in this tab to add, modify, or delete employment information.

!!! The Investigation and Intake processes require at least one employment record.

PTCC uses the last employment record entered as the current employment in
instances when employment information is needed.

Employment tab

The Employed and Total Net Income data fields are case-specific rather than employment-
specific. When either of these fields changes in one record, the field automatically changes in all
records.

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields on both tabs and enter another employment.
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Employment, continued
Employment (contd.) Tab
The Employment (contd.) tab is a continuation of the Employment tab. The tab captures and
displays additional information for the employment record.

Employment (contd.) tab

Click the New icon to clear the data fields on both tabs and enter another employment.
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Other Income

The Other Income sub-module captures and displays information about additional income
sources a case may have that are not a result of employment. The sub-module consists of one tab,
Other Income. The tab contains a summary list box showing: Income Type, From, To, Amount,
and Pay Freq. Select an other income record in the list box, and the details for that record appear
in the fields at the bottom section of the tab. Use the fields in this tab to add, modify, or delete
other income information.

Other Income tab

If Other is selected from the Type drop-down list, type a description of the Other Income in the
Other Description data field. Type the income source in the Source field. Type any identifying
number in the Reference No. field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
other income.
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Education

The Education sub-module captures and displays information about a case’s education. The sub-
module consists of one tab, Education. Use the fields in this tab to add, modify, or delete
education information.

!!! The Investigation and Intake processes require education information to be
completed.

Education tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.
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Military

The Military sub-module captures and displays information about a case’s prior military service.
The sub-module consists of one tab, Military. Use the fields in this tab to add, modify, or delete
military information.

Current military service should be entered in the Employment sub-module.

Military tab

If the person is eligible to receive Veteran Administration (VA) benefits for medical insurance,
select Yes from the VA Benefits Avail drop-down list. Type the location where the person served
military duty in the Location field.

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.
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Substance Use

The Substance Use sub-module captures and displays information about a case’s current and
past substance use. The sub-module consists of one tab, Substance Use. The tab contains a
summary list box showing: LOU (length of use) Yrs, LOU Mos, Substance, Frequency, Method of
Intake, and Date of Last Use. Select a substance use record in the list box, and the details for that
record appear in the fields at the bottom section of the tab. Use the fields in this tab to add,
modify, or delete substance use information.

The following fields are required for the selected process:
• Interview: Substance.
• Investigation or Intake: Substance, Frequency, Length of Use (yrs./mos.),

Date of Last Use, Age at First Use, and No. of Times Used (Last 30 Days).

Substance Use tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
substance use record.



PTCC User Guide

PTCC Case Management System4-18

Substance Treatment

The Substance Treatment sub-module captures and displays information about a case’s current
and past substance treatment. The sub-module consists of one tab, Substance Treatment. The tab
contains a summary list-box showing: Treatment From, Treatment To, Primary Substance,
Provider, Status and Contact. Select a substance treatment record in the list box, and the details
for that record appear in the fields at the bottom section of the tab. Use the fields in this tab to
add, modify, or delete substance treatment information

The following fields are required for the selected process:
• Interview: Primary Substance.
• Investigation or Intake: Type, Primary Substance, and Status.

Substance Treatment tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
substance treatment.
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Health Issues

The Health Issues sub-module captures and displays information about a case’s health, not
including substance use information. The sub-module consists of one tab, Health Issues. The tab
contains a summary list box showing: From, To, Health Issue, Provider, Current Status, and
Contact. Select a health issue record in the list box, and the details for that record appear in the
fields at the bottom section of the tab. Use the fields in this tab to add, modify, or delete health
issue information.

The following fields are required for the selected process:
• Interview: Issue.
• Investigation or Intake: Issue and Status.

Health Issues tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
health issue.
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Other Ed/Tx Programs

The Other Ed/Tx Programs sub-module captures and displays information about a case’s current
or prior education and treatment, other than substance abuse education and treatment. The sub-
module consists of one tab, Other Ed/Tx Programs. The tab contains a summary list box showing:
Program Type, For, From, To, Provider, Status, and Contact. Select an education or treatment
program record in the list box, and the details for that record appear in the fields at the bottom
section of the tab. Use the fields in this tab to add, modify, or delete other ed/tx program
information.

The following fields are required for the selected process:
• Interview: Education or Treatment, and For.
• Investigation or Intake: Education or Treatment, and For and Status.

Other education and treatment includes such things as: Anger Management,
Financial Responsibility, or Sex Offender Treatment.

Other Ed/Tx Programs tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
education or treatment program.
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Assessment Tests

The Assessment Tests sub-module captures and displays information about assessment tests
given to a defendant or offender. The sub-module consists of one tab, Assessment Tests. The tab
contains a summary list box showing: Test Type, Date, and Score. Select an assessment test
record in the list box, and the details for that record appear in the fields at the bottom section of
the tab. Use the fields in this tab to add, modify, or delete assessment tests information.

Assessment Tests tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
assessment test.
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Criminal Events

The Criminal Events button provides access to the last three Setup sub-modules. When the
Criminal Events button is clicked, the system opens to the Pending Charges sub-module, and
provides access to the Outstanding Warrants and Prior Criminal Activity sub-modules.

Pending Charges

The Pending Charges sub-module captures and displays information about charges pending
against a defendant or offender. The sub-module consists of one tab, Pending Charges. The tab
contains a summary list box showing: Arrest Date, Unknown, CC (Charge Classification),
Category, Descriptor, Next Appearance, and Hearing Type. Select a pending charge record in the
list box, and the details for that record appear in the fields at the bottom section of the tab. Use
the fields in this tab to add, modify, or delete pending charges information.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar.

Pending Charges tab

Click the Include Notes on Court Report check box to include these notes in the Court Report. If
the box is not checked, the notes will not appear on the Court Report.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
pending charge.
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Criminal Events, continued

Outstanding Warrants
The Outstanding Warrants sub-module captures and displays information about any outstanding
warrants for a case. The sub-module consists of one tab, Outstanding Warrants. The tab contains
a summary list box showing: Issue Date, Unknown, CC (Charge Classification), Category, and
Descriptor. Select an outstanding warrant record in the list box, and the details for that record
appear in the fields at the bottom section of the tab. Use the fields in this tab to add, modify, or
delete outstanding warrants information.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar.

Outstanding Warrants tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
outstanding warrant.
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Prior Criminal Activity

The Prior Criminal Activity sub-module captures and displays information about a case’s prior
criminal activity. The sub-module contains two tabs: Charges and Sentence.

Charges Tab
The Charges tab captures and displays information about a case’s prior criminal activity. The tab
contains a summary list box showing: Arrest Date, Disposition Date, CC, Category, Descriptor,
Locality, and Disposition. Select a charge record in the list box, and the details for that record
appear in the fields at the bottom section of this tab and on the Sentence tab. Use the fields in
this tab to add, modify, or delete prior criminal activity information.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar.

Charges tab

Use the Source of Info data field to record where the information was received, such as from the
VCIN Report. If the charge was part of the cases’s juvenile record, click the Juvenile check box.

Click the New icon to clear the data fields on both tabs and enter another prior criminal activity.



Chapter 4-Setup Module

October 2002 Virginia Department of Criminal Justice Services 4-25

Prior Criminal Activity, continued
Sentence Tab
The Sentence tab captures and displays disposition and sentencing information about the prior
criminal activity record selected on the Charges tab.

Sentence tab

Click the New icon to clear the data fields on both tabs and enter another prior criminal activity.
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Chapter 5: Jail Admissions Module
The Jail Admissions module captures and displays Jail Admissions information, which is
obtained from jail records.

Jail Admissions information is required for the Pretrial Services Monthly Report.

Accessing the Jail Admissions Window

Jail Admissions is a module that Pretrial uses to document the number of admissions to jail.
Follow the steps in the procedure below to access the window:

Click Modules>Jail Admissions on the PTCC tool bar.

Result: The Jail Admissions window appears.

Jail Admissions
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Jail Admissions, continued

The Jail Admissions window contains a summary list box showing: Jail, Admission Date, Felony
Count, and Misd. Count.

Entering Jail Admissions Information

Follow the steps in the procedure below to enter jail admissions information:

1. Select the date of admissions from the Admission Date drop-down calendar.

2. Select the Jail from the drop-down list.

3. Enter the number of defendants admitted for misdemeanor charges in the Misdemeanor data
field.

4. Enter the number of defendants admitted for felony charges in the Felony data field.

5. Click the Save button to save the jail admissions information.

Click the New button to clear the fields at the bottom section of the window, and enter new jail
admissions information.

Deleting Jail Admissions Information

Follow the steps in the procedure below to delete jail admissions information:

1. select a jail admission in the summary list box, and

2. click the Delete button to delete the line.
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Chapter 6: Screening Module
The Screening module captures and displays defendant information for a single arrest event. An
arrest event includes at least one charge, but may include multiple charges. As you work through
the Screening sub-modules, any information entered is associated with the screening selected in
the Screening tab. The Screening module consists of the following sub-modules:

• Screening
• Charges
• Court Assignment
• Court Reports
• Recommendation
• Charge Update
• Court Update
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Screening

The Screening sub-module captures and displays information about a single arrest event. The
sub-module contains one tab, Screening. The tab contains a summary list box showing: Scr.
Date, Jail Name, PCC, Scr. In, Reason Screened Out, and Investigated. Select a screening record
in the list box, and the details for that record appear in the fields at the bottom section of the tab.
Information must be entered and saved in this tab before continuing in the Screening module.
Use the fields in this tab to add, modify, or delete screening details (see Appendix A: Deleting a
Case, Placement, and/or Screening on page A-1).

 This tab allows screening information to be entered for:
• an existing defendant using the Search feature or the Active Cases window, or
• a new defendant by clicking the New Defendant radio button and the New icon.

If entering a new defendant, you must enter information in the following fields:
First Name, Last Name, Race, Sex, DOB, and SSN.

Screening tab

If the defendant is screened out, select a reason from the Reason drop-down list. If the reason is
other, type the description in the Other Desc data field. Complete the Screened By and Date
fields. This will end the screening process for this arrest event.
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Screening, continued

If the defendant is screened in, but not investigated, select a reason from the Reason drop-down
list. If the reason is other, type the description in the Other Desc data field. Complete the
Investigated By and Date fields. Select Yes or No from the Criminal Record Check drop-down list,
to indicate whether a criminal record check will be provided.

If the defendant is screened out, not investigated, and no criminal record check is provided, the
screening process for this arrest event will end.

If the defendant is screened in and investigated; or screened in, not investigated, but a criminal
record check will be provided, the Screening process continues. Proceed next to the Charges
sub-module.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
screening.
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Charges

The Charges sub-module captures and displays information relating to the charges for a
particular arrest event. The sub-module contains three tabs: Original Charges, Co-Defendants,
and Victims.

Original Charges Tab
The Original Charges tab captures and displays information about the original charges for a
particular screening. The tab contains a summary list box showing: CC, Category, Descriptor,
and Primary Offense. Select a charge record in the list box, and the details for that record appear
in the fields at the bottom section of the tab, and the Co-Defendants and Victims tabs. Use the
fields in this tab to add, modify, or delete charges.

!!! All charges for the Screening arrest event must be entered in order to continue
the Screening process.

After each charge is entered, associated co-defendant and victim information
can be added by clicking the Co-Defendants or Victims tab.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar. When duplicating a charge, the
system prompts for duplication of the associated co-defendants and victims.

Original Charges tab
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Charges, continued

As new charges are entered, one and only one must be marked as the Primary Offense. If there is
more than one charge, the Primary Offense is the charge that is considered the most serious,
based on the maximum potential penalty for each charge.

Only changes to the original charge can be made here. To update the charge after a court
appearance, use the Charge Update tab.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
original charge.
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Charges, continued
Co-Defendants Tab
The Co-Defendants tab captures and displays information about co-defendants for the charge
selected in the Original Charges tab. The tab contains a summary list box showing: Name and
Relationship. Select a co-defendant record from the list box, and the details for that record appear
in the data fields at the bottom section of the tab. Use the fields in this tab to add, modify, or
delete co-defendants.

Co-Defendants tab

To add or view a co-defendant for another charge:
• go back to the Original Charges tab
• select the charge, and
• return to this tab.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another co-
defendant.
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Charges, continued
Victims Tab
The Victims tab captures and displays information about victims for the charge selected in the
Original Charges tab. The tab contains a summary list box showing: Name, Relationship, and
Notification. Select a victim record from the list box, and the details for that record appear in the
data fields at the bottom section of the tab. Use the fields in this tab to add, modify, or delete
victim information.

Victims tab

To add or view a victim for another charge:
• go back to the Original Charges tab
• select the charge, and
• return to this tab.

Type any property damage in the Property Damage data field. Select Death, Emotional, None,
Physical, Serious Physical, or Threatened from the Extent of Injury drop-down list. Select Yes or
No from the Notification Requested data field. Select the date the victim was notified of the
person’s release in the Date Notified field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
victim.
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Court Assignment

The Court Assignment sub-module captures and displays information required to assign charges
to the appropriate court. The sub-module consists of one tab, Court Assignment. The tab contains
two list boxes, Charges and Original Court Assignments. The Charges list box shows: CC,
Category, and Descriptor. The Original Court Assignments list box shows: CC, Category,
Descriptor, Court, Court Date, Court Time, and PCC. Charges that have not been assigned to a
court appear in the Charges list box on the left side of the tab. When a charge is assigned to a
court, the system moves the charge to the Original Court Assignments list box on the right. Use
the Ctrl key to select multiple charges for assignment. Use the slide bar at the bottom section of
the Original Court Assignments list box to see any hidden fields. Use the fields in this tab to add
or remove court assignment information.

!!! Charges must be assigned to a court before continuing the Screening process.

Selecting a charge and assigning it to a specific hearing type, court, date, and
time and then selecting a second charge and assigning it to the exact same
hearing type, court, date, and time does NOT link the two charges. Multiple
charges going to the same court must be selected and assigned as a group in
order for them to be processed together (use the Ctrl key to select multiple
charges for assignment).

The Delete icon removes court assignment information from the charge
highlighted in the Original Court Assignment list box. When the court
assignment is removed, the charge will move back to the Charges list box.

Court Assignment tab
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Court Assignment, continued
Assigning Charges to a Court
Follow the steps in the procedure below to assign charges to a court:
• Select the charge you want to assign to a court in the Charges list box. To select multiple

charges, hold down the Ctrl key when making your selections.
• Enter information in the fields at the bottom section of the tab.
• Press Save, and the charges appear in the Original Court Assignments list box.

Removing Charges from a Court Assignment
Follow the steps in the procedure below to remove charges from a court:
• Select the charge to be removed (unassigned) from a court in the Original Court Assignments

list box.
• Press Delete, and the charges will appear in the Charges list box.
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Court Reports

The Court Reports sub-module creates a court report for a particular court appearance. The sub-
module consists of one tab, Court Report History. The tab contains a summary list box showing:
Court, Court Date, Court Time, and Hearing Type for all courts that have had charges assigned for
the selected screening event. Select a Court Appearance record in the list box to create or view a
report. Once a Court Appearance record has been selected, type or modify the court report date
and the report summary information in the Report Summary field.

The report buttons are inactive until the Date Created field is complete, and the
Save icon is clicked.

If a Report Summary is entered, click the Save icon prior to selecting Full Report
or Prior Criminal Activity Only in order for the summary to appear on the Court
Report.

Any notes created in Setup modules, where Include on Court Report is checked,
will appear on the Full Report printout.

The Delete icon removes the date created and any report summary information
for the highlighted court, thereby deleting the record of the Court Report being
created. The court still appears in the summary list box, but it no longer has an
associated date or summary.

Court Reports tab
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Court Reports, continued
Creating a Court Report
To create a Court Report, follow the steps in the procedure below:
• select the court appearance from the All Court Appearances list box
• select the Date Created from the drop-down calendar
• if a summary is desired, type the summary in the Report Summary box
• click the Save icon, and
• click the button for the type of court report to be generated.

Printing Court Reports
The Court Reports sub-module has two buttons that print either a:
• Full Report—shows information entered in the Setup module, current charges, victims, and

the summary, or
• Prior Criminal Activity Only Report—shows basic demographic information entered in the

Setup module, current charges, victims, prior criminal activity, pending charges, outstanding
warrants, and the summary.

To print a Full Report:
• complete an investigation in Setup, and
• click the Full Report button.

To print a Prior Criminal Activity Only Report, click the Prior Criminal Activity Only Report button.
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Recommendation

The Recommendation sub-module contains information relating to a Pretrial staff’s current and
past recommendations for the selected court appearance. The sub-module contains two tabs:
Recommendations and History.

Recommendations Tab
The Recommendations tab captures and displays, for the selected court appearance, the Pretrial
staff’s bail recommendation for a defendant, and whether the judicial officer accepted or rejected
the recommendation. This information must be entered after the court appearance. The tab
contains a summary list box showing: Court, Court Date, Court Time, Hearing Type,
Recommendation, Rec. Date, Staff Recommending, and Court Action for all court appearances
associated with this screening. Select a court appearance record in the summary list box, and the
details for that record appear in the fields at the bottom section of the tab. Use the fields in this
tab to add, modify, or delete recommendations for the court appearances. To delete a
recommendation for a court appearance, highlight the Recommendation, and click the Delete
button. The court record remains in the list box, but the recommendation to that court is
removed.

Recommendations information is required for the Pretrial Services Monthly
Report. The information must be entered and saved before continuing the
Screening process.

The Delete icon removes the recommendation information that was entered for a
highlighted court appearance. The court still appears in the summary list box,
but it no longer has an associated recommendation.

Recommendations tab
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Recommendation, continued
Select the judge or magistrate that presided over the case from the Judicial Officer drop-down
list. If the judicial officer was a substitute, select substitute from the Judicial Officer drop-down
list, and type the substitute’s name in the Substitute Officer data field.

History Tab
The History tab shows the case’s Past Court Appearances, with respective recommendations for
all appearances in a particular court. The tab contains a summary list box showing: Court, Court
Date, Court Time, Hearing Type, Jud. Officer, Sub. Jud. Officer, Recommendation, Rec. Date, Staff
Recommending, and Court Action. The information in this tab is view only; you cannot add,
modify, or delete it.

The History tab shows a history of the recommendations for the court selected
on the Recommendations tab.

History tab
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Charge Update

The Charge Update sub-module captures and displays information regarding any updates to the
charges record after a defendant appears in court. The sub-module consists of one tab, Charge
Update. The tab contains a summary list box showing: CC, Category, Descriptor, Current Bond
Type, and Current Bond Amount. The summary list box contains all charges associated with the
selected screening that have been assigned to a court. Select a charge record in the list box, and
the details for that record appear in the fields at the bottom section of the tab. Use this tab to
modify charges only; they cannot be added or deleted.

If the charge has been referred to Pretrial Supervision, make sure Referred to PT
has been selected from the Outcome drop-down list.

If the charge has been sentenced to Community Corrections, make sure the
Referred to CC check box at the bottom section of the tab has been selected.

The Delete icon removes any charge update information that may have been
entered about the highlighted charge, and restores the charge to its previous
charge update status or to its original charge status. The charge still appears in
the summary list box, but it no longer has the updated information. If a charge is
deleted from the Charge Update screen that has been Referred to PT or Referred
to CC and subsequently assigned to a placement, it also removes the charge from
its PT- or CC-respective assignment.

Charge Update tab
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Charge Update, continued

Modifications made on this tab will not affect the original charge being displayed on the Original
Charges tab in Screening. To modify the original charge, return to the Charges sub-module and
make the change there.
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Court Update

The Court Update sub-module allows for the update of court information related to a specific
charge or group of charges. The sub-module consists of one tab, Court Update. The tab contains a
summary list box showing: CC, Category, Descriptor, Court, Court Date, Court Time, and PCC.
The summary list box contains all charges associated with the selected screening that have been
assigned to a court. Select a court appearance record in the list box, and the details for that record
appear in the fields at the bottom section of the tab. Use this tab to modify Court Update records
only; they cannot be added or deleted.

To assign more than one charge to the same court, press the Ctrl key, select all
charges you want to assign to the court, and assign them all at once.

The Delete icon removes any court update information that may have been
entered about the highlighted charge, and restores the previous court
information for the charge. The charge still appears in the list box, but it no
longer has court update information.

Court Update tab

Select the judge or magistrate that presided over the case from the Judicial Officer drop-down
list. If the judicial officer was a substitute, select substitute from the Judicial Officer drop-down
list, and type the substitute’s name in the Subst. Judge data field.
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Court Update, continued

Upon modifying court information, the updated court will be available for a new court report and
recommendation (new court information now appears on the Court Reports and
Recommendations tabs).
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Chapter 7: Pretrial Placement Module
This chapter contains information about the Pretrial Placement module. Pretrial Placement is
used to set up a placement for a defendant that is to be supervised while awaiting trial. While
working through the Pretrial Placement sub-modules, any information entered is associated with
the placement selected in the Placement tab. Pretrial Placement contains the following sub-
modules:

• Placement
• Charges
• Conditions
• Payment Obligations
• Court Dates
• Attorney
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Placement

The Placement sub-module captures and displays defendant placement information. The sub-
module contains two tabs: Placement and Status/Closure. The information in the remaining sub-
modules relate to the placement selected in the Placement tab. Before continuing to the other
sub-modules in Pretrial Placement, be sure to select the appropriate placement from the summary
list box.

Placement Tab
The Placement tab contains a summary list box showing: Referral Date, PCC, Court/Locality, and
Current Status. A defendant can have multiple placements, which appear on separate lines and
are separate records in the list box. Select a placement record from the list box, and the details
for that record appear in the fields at the bottom section of this tab, and on the Status/Closure tab.
Use the fields in this tab to add, modify, or delete (with limitations, see Appendix A: Deleting a
Case, Placement, and/or Screening on page A-1) pretrial placement information.

All Active, Inactive, and Pending Pretrial placements for a defendant must be
assigned to the same case manager. Therefore, if a defendant has existing
Active, Inactive, or Pending placements assigned to one case manager, and a
new placement is added and assigned to a different case manager, the new case
manager inherits all existing Active, Inactive, or Pending placements.

Placement tab
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Placement, continued

Enter the date the placement was referred to Pretrial Supervision in the Referral Date data field. If
a judge referred the placement, select the Judge radio button and enter the referring court, and
the referring judge. If a magistrate referred the placement, select the Magistrate radio button and
enter the referring locality and the referring magistrate. Select the judge or magistrate from the
Judicial Officer drop-down list. If the judicial officer was a substitute, select Substitute from the
Judicial Officer drop-down list and type the substitute’s name in the Subst. Jud. Officer data field.

Make a selection from the Supervision Level drop-down list, if appropriate. Select Monitor Only
for placements that do not require traditional supervision, but do need to be monitored to remind
them of the court date. If this placement is a reinstatement, click the Reinstatement check box,
and enter the original placement number that is associated with this reinstatement. This does not
link the two placements in any way, but shows the placement associated with the reinstatement.

!!! Placements checked Monitored Only will not be included in Sections I and III of
the Pretrial Services Monthly Report.

Click the New icon to clear the data fields on both placement tabs and enter another placement.
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Placement, continued
Status/Closure Tab
The Status/Closure tab captures and displays placement status and closure information, as well
as information about the placement’s transfer status. When the current status of the placement
status changes, PTCC makes an entry showing: Status, Status Date, and Inactive Reason in the
Placement Status History window, which can be accessed by clicking the Status History button.

See page 7-6 for detailed information about business rules associated with this
tab.

Status/Closure tab

If the placement was received from another locality, go to the Transfer In group and select the
locality from the From drop-down list, and the transfer date from the Date Received drop-down
calendar. Upon returning the placement back to the original locality, select the Date Sent Back
from the drop-down calendar, and select Transferred in-Sent Back as the closure type to close the
placement.



Chapter 7-Pretrial Placement Module

October 2002 Virginia Department of Criminal Justice Services 7-5

Placement, continued

If transferring a placement to another locality, go to the Transfer Out group and select the locality
from the To drop-down list and the transfer date from the Date Sent Out drop-down list. Change
the Current Status to Inactive, the reason to Transferred Out, and select the Status Date from the
drop-down calendar. Upon receiving the placement back, go to the Transfer Out group and select
the date from the Date Returned drop-down calendar, and update the Current Status and Status
Date, accordingly.

Note: If there is more than one active or inactive placement for the defendant, all placements are
automatically transferred out to the same locality using the information entered on this tab
(Transferred Out To, Date Sent Back, Status, Status Date, and Reason Inactive). These
placements can be returned on a one-by-one basis for closure. If any are returned to Active or
Inactive status, the system automatically returns all of them to Active or Inactive status using the
information entered on this tab (Transferred Out, Date Returned, Status, Status Date, and Reason
Inactive).

Only users with Supervisor rights in PTCC can enter Closed Review Date.

Click the New icon to clear the data fields on both placement tabs and enter another placement.

Placement Status History Window
Click the Status History button, at the bottom section of the Status/Closure tab, to access the
Placement Status History window. The Placement Status History window shows: Status, Status
Date, and Inactive Reason for the placement currently selected. The window provides a quick
overview of the placement’s status history, for instance it shows when and why the status
changed from active to inactive. Information in this window is view only; it cannot be added,
modified, or deleted.

Placement Status History window
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Placement, continued
Pretrial Placement Rules
The following rules apply to Pretrial Placements:

Pending Rules
• Placements that leave Pending status can never return to Pending status.
• A Pending-Close closure type only applies when current status is Pending, and is the only

way to close a Pending placement.
• You may enter the following information about a Pending placement:
- Charges
- Co-Defendants
- Victims
- Conditions
- Payment Obligations
- Court Dates
- Attorney
- Setup information
- Pending Charges
- Outstanding Warrants
- Prior Criminal Activity

• No supervision activity can be entered in the PT Supervision module while a placement has a
status of Pending.

Status Rules
• A new Status Date is required whenever Current Status changes.
• The new Status Date must be greater than the current Status Date.
• If Current Status changes from active to inactive for one placement, ALL placements for the

defendant that are NOT closed or pending, become inactive with the same Reason and Status
Date; however, no new Status Date can be less than any other placement’s current Status
Date. (See Example 1.)

• If Current Status changes from inactive to active, ALL placements for that defendant, that are
NOT closed or pending, become active with the same Status Date; however, no new Status
Date can be less than any other placement’s current Status Date. (See Example 2.)

Example 1: Placement 1 Active 10/05/01
Placement 2 Active 10/20/01

Placement 1 cannot be made inactive on 10/12/01; the date must be greater than
10/20/01.

Example 2: Placement 1 Inactive 10/05/02
Placement 2 Inactive 10/05/02

A new active placement cannot be opened before 10/06/02; and neither existing
placement can be changed to have an active date before 10/06/02.
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Placement, continued
Closure Rules
• To close a placement as Successful, all charges must have a disposition and there can be no

future court dates.
• Once a placement is closed, changes to any of the placement information cannot be made

(this includes changing other sub-modules in the Placement module).

Transfer In Rules
• Entering information in the Transfer-In group, From field requires information to be entered

in the Date Received field, and vice-versa.
• Use the Transfer In–Date Sent Back closure type only when the placement type is Transferred

In (this is the only way to close a Transferred In placement).
• To close a Transfer In, you must enter the Date Sent Back.

Transfer Out Rules
• Entering information in the Transfer-Out group, To field requires information to be entered in

Date Sent Out, and vice versa.
• When placements are transferred out, you must make the status Inactive with an Inactive

Reason of Transferred Out.
• When placements are transferred out, all other active and inactive placements will

automatically be transferred out with the same information; however, you can return and
close Transferred Out placements on a one-by-one basis.

• If a Transferred Out placement is made active, enter the information in the Transfer-Out
group Date Returned field, and all inactive placements automatically become active again
with the same Date Returned.

• Before closing a Transferred Out placement, you must enter information in the Transfer-Out
group Date Returned field.
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Charges

The Charges sub-module captures and displays a variety of information relating to a defendant’s
charges. The sub-module contains five tabs: Existing Charges, New Charges, Co-Defendants,
Victims, and Amend/Disposition. Assign charges to a placement in either the Existing Charges or
New Charges tabs. You cannot assign both Existing Charges and New Charges to the same
placement.

Existing Charges Tab
The Existing Charges tab allows charges to be assigned to a placement that were entered in
Screening and marked Referred to PT. The Existing Charges tab has two summary list boxes,
Assigned Charges and Unassigned Charges. The list boxes show: Arrest Date, Primary Offense,
Current Category, Current Descriptor, Current CC, Orig. Category, Orig. Descriptor, and Orig. CC.
Select a charge record in either of the list boxes, and the details for that record appear in the
fields at the bottom section of the tab. Use the Assign Charge to Placement check box in this tab
to assign any of the defendant’s unassigned charges to the placement selected on the Placement
tab.

You can assign Existing Charges to a placement if the charges associated with
the placement were marked as, Referred to PT in the Charges Update tab in the
Screening module.

Existing Charges tab
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Charges, continued
Assigning Charges
Follow the steps in the procedure below to assign existing charges to a placement:

1. Select the charge from the Unassigned Charges list box on the right. Only one charge can be
assigned at a time.

2. Click the Assign Charge to Placement check box.

3. Save the record.

Result: When the record saves, the charge moves to the Assigned Charges list box.

Existing Charges cannot be modified from the Charges sub-module. To make a
change: unassign the charge, return to Charge Update in Screening, make the
change, and return to the Existing Charges tab to reassign the charge.

Unassigning Charges
Follow the steps in the procedure below to unassign charges:
• Select the charge from the Assigned Charges list box. Only one charge can be unassigned at

a time.
• De-select the Assign Charge to Placement check box.
• Save the record.

Result: When the record saves, the charge moves back to the Unassigned Charges list
box on the right.
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Charges, continued
New Charges Tab
The New Charges tab allows the entering of charges associated with the placement that were not
previously entered in Screening. The tab contains a summary list box showing: Arrest Date,
Primary Offense, Current Category, Current Descriptor, Current CC, Orig. Category, Orig.
Descriptor, and Orig. CC. Select a charge record in the list box, and the details for that record
appear in the fields at the bottom section of the tab. Use the fields in this tab to add, modify, or
delete new charges.

New Charges tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
charge.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar. When duplicating a charge, the
system prompts for duplication of the associated co-defendants and victims.

As new charges are entered, one and only one must be marked as the Primary Offense. If there is
more than one charge, the Primary Offense is the charge that is considered the most serious,
based on the potential maximum penalty of each charge.
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Charges, continued
Co-Defendants Tab
The Co-Defendants tab captures and displays information about co-defendants for the charge
selected in the Existing Charges or New Charges tab for a particular placement. The tab contains
a summary list box showing: Name and Relationship. Select a co-defendant record in the list box,
and the details for that record appear in the data fields at the bottom section of the tab. Use the
fields in this tab to add, modify, or delete co-defendants.

Co-Defendants Tab

To add or view a co-defendant for another charge:
• go back to the Existing Charges or New Charges tab
• select the charge, and
• return to this tab.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another co-
defendant.
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Charges, continued
Victims Tab
The Victims tab captures and displays information about victims for the charge selected in the
Existing Charges or New Charges tab for a particular placement. The tab contains a summary list
box showing: Name, Relationship, and Notification. Select a victim record in the list box, and the
details for that record appear in the data fields at the bottom section of the tab. Use the fields in
this tab to add, modify, or delete victims.

Victims Tab

To add or view a victim for another charge:
• go back to the Existing Charges or New Charges tab
• select the charge, and
• return to this tab.

Type any property damage in the Property Damage data field. Select Death, Emotional, None,
Physical, Serious Physical, or Threatened from the Extent of Injury drop-down list. Select Yes or
No from the Notification Requested data field. Select the date the victim was notified of the
person’s release in the Date Notified field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
victim.
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Charges, continued
Amend/Disposition Tab
The Amend/Disposition tab allows the amendment of a charge, or the recording of the disposition
of a charge. Any amendment or disposition entered in this tab is for the placement selected on
the Placement tab, and the charge selected on the Existing Charges or New Charges tab. Before a
placement can be closed as Successful, the charge disposition information must be completed.

Amend/Disposition tab

Making an Amendment
To make an amendment:
• click the Amendment radio button
• enter the new charge in the Virginia Code group, and
• select the Amend Date from the drop-down calendar.

Select the judge from the Judge drop-down list. If Substitute is selected from the Judge drop-
down list, type the substitute’s name in the Subst. Judge data field.
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Charges, continued
Amendment History Window
The Amendment History window allows information to be viewed only; it cannot be added,
modified, or deleted. The window contains a summary list box showing: Amended Date,
Category, Descriptor, Charge Class, and VCC (Virginia Crime Code). Follow the procedure
below to view a defendant’s Amendment History.

1. Click the Amendment History button.

Result: The Amendment History window opens.

Amendment History window

2. Click the OK button to close the window.

Entering a Disposition
To enter a disposition:
• click the Disposition radio button
• select the Disposition from the drop-down list
• select the Disposition Date from the Date drop-down calendar
• if the sentence for this charge includes Community Corrections, select Community

Corrections Supervision from the drop-down list as the Community Sentence Type.

Entering an Amendment or Disposition for Another Charge
To enter an amendment or disposition for another charge:
• go back to the Existing Charges or New Charges tab
• select the charge, and
• return to this tab.
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Conditions

The Conditions sub-module displays the standard State Condition of Supervision, and allows the
addition of Additional Conditions (locally defined), and/or Other Conditions (unique conditions)
for the defendant. The sub-module contains one tab, Conditions. The tab contains a summary list
box showing either the State Conditions or Additional Conditions depending on the radio button
selected in the Conditions to View group. Conditions entered in this tab are for the placement
selected in the Placement tab.

State Conditions are automatically entered for the defendant; they cannot be
modified. Once entered, Additional Conditions can be added or removed, and
Other Conditions can be added, modified, or deleted.

Conditions tab

Select the date the Conditions take effect from the Date drop-down calendar. Select Yes or No
from the Agreement Signed drop-down list to indicate whether the defendant signed the
Conditions of Supervision form.
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Conditions, continued
Adding Additional Conditions
Follow the steps in the procedure below to add additional conditions.

1. Select the Additional radio button in the Conditions to View group, and click the Ellipse
button.

Result: The Additional Conditions window appears with Additional conditions on the left.

Additional Conditions window

2. Highlight the Additional Condition to be imposed, click the Add button, and the Additional
condition moves to the list box on the right.

There is no limit to the number of Additional Conditions that a judicial officer
may impose and that can be entered.

3. Click the OK button and the condition appears in the Conditions tab.
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Conditions, continued
Removing Additional Conditions
To remove Additional Conditions:
• select the condition to be removed on the right
• click the Remove button, and the condition moves back to the list box on the left.

Entering Other Conditions
Follow the steps in the procedure below to enter Other conditions.

1. Type the unique condition in the Other Conditions memo box on the Conditions tab.

Other Conditions memo box

2. Click Save.

Removing Other Conditions
To remove Other Conditions:
• select the condition to be removed in the Other Conditions memo box, and
• press the Delete key on the keyboard.
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Payment Obligations

The Payment Obligations sub-module captures and displays information about a defendant’s
payment obligations for the placement selected in the Placement tab. The sub-module consists of
one tab, Payment Obligations. The tab contains a summary list box showing: Obligation, Date
Imposed, Final Amount Due, and Balance Remaining. Select a payment obligation record in the
list box, and the details for that record appear in the fields at the bottom section of the tab. Use
the fields in this tab to add, modify, or delete payment obligations.

As payments are entered in the Supervision module, the system automatically
updates the following data fields in the Payment Obligations tab:
• Final Amount Due
• Last Payment
• Amount Paid To Date
• Balance Due

Payment Obligations tab

If a defendant’s payment obligation amount is not defined, click the Undefined check box. Select
Court Clerk, Program, or Victim from the Remit To drop-down list, depending on who will receive
the payments. Type any adjustments to Payment Obligations in the Adjustment data field, and
type the reason for the adjustment in the Reason data field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
payment obligation.
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Court Dates

The Court Dates sub-module captures and displays information about future court dates for the
placement selected in the Placement tab. The sub-module consists of one tab, Court Dates. The
tab contains a summary list box showing: Court, Court Date, and Hearing Type. Select a court
date record in the list box, and the details for that record appear in the fields at the bottom section
of the tab. Use the fields in this tab to add, modify, or delete court dates.

Court Dates tab

If the court requires the case manager to appear in court with the defendant for any reason, select
the Case Manager needed in Court w/ Defendant check box. If the judge is a substitute, select
Substitute from the Judge drop-down list, and type the substitute’s name in the Substitute Judge
data field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
court date.
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Attorney

The Attorney sub-module captures and displays attorney information for the placement selected
on the Placement tab. The sub-module consists of one tab, Attorney. The tab contains a summary
list box showing: Attorney Name, Attorney Type, and Start Date. Select an attorney record in the
list box, and the details for that record appear in the fields at the bottom section of the tab. Use
the fields in this tab to add, modify, or delete attorney information.

Attorney tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
attorney.
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Chapter 8: Pretrial Supervision Module
This chapter contains information about the Pretrial Supervision module, which captures and
displays all supervision-related information for defendants. Pretrial Services Supervision
contains the following sub-modules:

• Schedule
• Case Notes
• Referrals
• UDS
• Payment Obligations
• Non-Compliance

Pretrial Supervision window
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Schedule

The Schedule sub-module shows a calendar of the defendant’s scheduled appointments. A Folder
icon on a calendar date indicates an appointment has been scheduled. Click the folder and a list
of activities scheduled for that date appears in the Activities list box at the bottom section of the
window. The Activities list box shows: Date, Type, and Note. You can schedule new
appointments, delete existing appointments, or enter contact notes for a scheduled appointment
from this window. More than one appointment can be made for the same date.

Schedule window

Use the slide bar at the bottom section of the calendar to help select the date.
• Click to the right or left of the slide button to change the year.
• Click the left or right arrow to change the month.
• Click and drag the slide button to get to dates that are more than a few years in the past or

future.

Click the New button to clear the data fields in the tab and enter another appointment.
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Schedule, continued
Entering Schedule Information
To enter defendant schedule information:
• click the Quick-Add button to enter recurring appointments, or
• click the New button to enter one appointment at a time.

Viewing Appointment Details
To view the details of an appointment:
• click the Folder icon for the date, and
• double-click the appointment from the Activities list box, or
• select the appointment and click the Detail button at the bottom section of the window.

Deleting Scheduled Appointments
To delete a scheduled appointment:
• click the Folder icon for the date
• select the appointment from the Activities list box, and
• click the Delete button at the bottom section of the window.

Filtering Appointment Types
To filter appointments shown in the Activities list box using a specific Filter option:
• click the Filter drop-down arrow, and
• select a filter from the Filter drop-down list.



PTCC User Guide

PTCC Case Management System8-4

Schedule, continued
Quick Add
Click the Quick Add button, and the New Schedule window appears. This window allows you to
schedule the same appointment type for multiple dates. When entering appointments on this
window, a Folder icon appears on all appropriate dates on the calendar.

New Schedule window

When scheduling appointments using Quick Add, the following information is required:
Appointment Type, Start Date, Frequency, and Occurrences. If you schedule an appointment to
occur on the 1st, 2nd, etc. week of the month, Day is also required.

Example 1: This shows how to schedule a recurring weekly appointment for six weeks. Follow
the steps in the procedure:

1. Enter the information in the New Schedule window as follows:

New Schedule window
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Schedule, continued

2. Click the OK button.

Result: A Folder icon for an Office Visit appears on every Wednesday for six weeks from
the date of the first appointment.

Schedule window

3. Click on the Folder icon and the appointment Date, Type, and Note appears in the Activities
list box at the bottom section of the window.

Example 2: This shows how to schedule an appointment for the first Tuesday of each month for
six months, starting June 4th. Follow the steps in the procedure below:

1. Enter the information in the New Schedule window as follows:

New Schedule window
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Schedule, continued

2. Click the OK button.

Result: A Folder icon for an Office Visit appears on the first Tuesday for the next six
months from the date of the first appointment.

Schedule window

3. Click on the Folder icon and the appointment Date, Type, and Note appears in the Activities
list box at the bottom section of the window.
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Schedule, continued
New
To add a new appointment or contact note, click the New button and the Schedule Detail window
appears. The window serves two purposes as follows:
• schedule an appointment in the top of the window, or
• enter a Contact Note about a scheduled appointment in the bottom section of the window.

A Contact Note cannot be entered here unless an appointment was scheduled.

Not all Contact Notes can be entered from here. Referrals, UDS, Payments, Non-
Compliance, and Graduated Sanctions must be entered through their respective
sub-module in the PT Supervision module.

Saving a Contact Note record creates an entry in the Case Notes Log that shows:
Contact Date, Contact Type, Time, Defendant Present, and Contact Note. The
information can be viewed from the Case Notes window. Once a Contact Note
has been entered and saved, it cannot be changed or deleted.

Schedule Detail window

If the defendant was present for the contact, click the Defendant Present check box.
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Case Notes

The Case Notes sub-module serves two functions, it allows for the:
• entering of a New Note for a defendant, or
• displaying of View Notes for a defendant.

New Note
Click the New Note radio button to enter a case note about a defendant for a specific date.

Case Notes window

Select the note type from the Type drop-down list, select the date, and type in the time. If the
defendant was present for the contact, click the w/Defendant check box.

Type the note in the Notes field, and click the Save button. Once the note is saved, it cannot be
modified or deleted. A new note, however, can be entered.
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Case Notes, continued
View Notes
Click the View Notes radio button to view notes about a defendant over a specified period of
time.

Case Notes window

To filter the case notes by a specific type and/or date range, select the note type from the Type
drop-down list and/or select Date Start and Date End, and click the Run button. If no filtering
information is entered, all case notes will appear on the log.

Result: All case notes, based on the criteria selected, appear in a report called Case Notes
Log. To print the report, click the Print icon at the top of the report window.

Case Notes Log

See Chapter 11: Reports and Forms for more information about other reports.
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Referrals

The Referrals sub-module captures and displays information needed to refer a defendant to an
education or treatment program, as well as to record the first substance abuse testing. The sub-
module contains a summary list box showing: Referral, Referral Date, and End Date. Select a
referral record in the list box, and the details for that record appear in the fields at the bottom
section of the window. Use the fields in this sub-module to add, modify, or delete referrals.

!!!

Referral information is part of the Pretrial Services Monthly Report, therefore, all
referrals must be entered.

The Date First Attended field must be completed for the New Service
Placement to be counted on the Pretrial Services Monthly Report.

A defendant’s first substance abuse testing is considered a referral, and must be
entered here to receive credit on the Pretrial Services Monthly Report.

Saving a Referral record creates an entry in the Case Notes Log that shows:
Referral Date, Contact Type, Referral Type, Where, Date First Attended, Staff,
and Outcome. The information can be viewed from the Case Notes window.

Referrals window

Date First Attended and End Date are required when the Outcome for the referral is Successful.
Date First Attended and Outcome are required when an End Date is entered. If the referral is a
result of a graduated sanction due to a non-compliance issue, select the Graduated Sanction
check box. If this referral was initiated in Community Corrections and then transferred
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Referrals, continued

to Pretrial, select the Transferred from CC check box. Select Insurance, Program, Other, or Self
from the Who Pays drop-down list to identify who is responsible for paying for the service.
Select Court Ordered, Employment Directed, Other, or Voluntarily from the Entered drop-down
list to identify how the person entered the education or treatment program.

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the tab, and enter another
referral.
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UDS

The UDS (Urine Drug Screen) sub-module captures and displays information about drug tests
performed for the defendant. The sub-module contains two tabs: Test Information and Test
Results. The window contains a summary list box showing: Collected, Result Date, Result, and
Test Type. Select a UDS record in the list box, and the details for that record appear in the fields
in the tabs at the bottom section of the window. Use the fields in the tabs to add, modify, or
delete UDS information.

Test Information Tab
The Test Information tab allows the capturing and viewing of information about the collection
and testing of UDS’. Information in this tab must be saved before continuing to the Test Results
tab. Date of Results must be entered for the test results to appear in the Results column of the
summary list box. If data is only entered in the Test Information tab, a case note is not added to
the Case Notes Log.

Test Information tab

Select the staff person who collected the UDS from the Collected By drop-down list. Type the
name of the technician who tested the sample in the Technician field. Use the Test Location field
to record where the sample was tested. Type the name of the lab that conducted the test in the
Lab field.

Click the New button to clear the data fields on both tabs and enter another UDS.
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UDS, continued

Test Results Tab
The Test Results tab captures and displays the drugs the defendant was tested for, and the results
of those tests.

Saving Test Results creates an entry in the Case Notes Log that shows: Date
Collected, Contact Type, Drug Test Type, Drugs Tested, Results, Staff, and
Notes. The information can be viewed from the Case Notes window.

Test Results tab

To select a drug: highlight the drug on the left, click the Add button and the drug appears on the
right.

To remove a drug: highlight the drug on the right, click the Remove button and the drug appears
on the left.

Mark positive results by clicking the check box next to the drug.

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields on both tabs and enter another UDS.
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Payment Obligations

The Payment Obligations sub-module captures and displays information about payments made
by the defendant. The sub-module contains a summary list box showing: Placement, Status,
Status Date, and Referral Date. Select a placement record from the list box, and the payment
obligations for that placement appear in the Obligations list box. If payments have been made for
a particular obligation, a + sign appears next to the obligation. Click the + sign and the payments
made toward that obligation appear in the Obligations list box. Highlight a specific payment to
modify or delete it. Add new payments by selecting a placement, selecting an obligation,
entering the amount and the date, and clicking the Save icon.

Only Active and Inactive placements appear on the PT Supervision Payment
Obligations window.

The actual Payment Obligation must be entered in the PT Placement module
Payment Obligations sub-module in order to appear here.

Saving a Payment record creates an entry in the Case Notes Log that shows:
Arrest Date and Referral Date for the placement, plus Contact Type, Date Paid,
Amount Paid, Balance Due, Staff, and Notes. The information can be viewed
from the Case Notes window.

Payment Obligations window

The Amount Paid field is limited to less than $1,000. If the payment made is greater than or equal
to $1,000, enter the payment as two separate payments. The Payment No field will automatically
fill once a payment has been entered and saved. If there is a receipt number, enter it in the
Receipt No field. If information is entered in the Note field and the Save button is clicked, the
note cannot be modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields on the right side of the tab, and enter additional
payments made.
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Non-Compliance

The Non-Compliance sub-module captures and displays information about a defendant’s non-
compliance issues. The sub-module contains a summary list box showing: Non-Compliance Type,
Date, and Action Taken. Select a non-compliance issue record in the list box, and the details for
that record appear in the fields at the bottom section of the sub-module. Use the fields in this
sub-module to add, modify, or delete non-compliance issues.

Saving a Non-Compliance record creates an entry in the Case Notes Log that
shows: Non-Compliance Date, Contact Type, Non-Compliance Type, Action,
Staff, and Notes. The information can be viewed from the Case Notes window.

Non-Compliance window

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the tab, and enter another
non-compliance.

Graduated Sanctions Button
The Graduated Sanctions button allows access to the Graduated Sanctions window, which
captures and displays graduated sanction information imposed against a defendant. If the non-
compliance issue results in Graduated Sanctions being imposed:
• select the Graduated Sanction Imposed check box
• save the non-compliance record, and
• click the Graduated Sanctions button to activate the Graduated Sanctions window.
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Non-Compliance, continued
Graduated Sanctions Window
The Graduated Sanctions window captures and displays information about graduated sanctions
imposed for the defendant. The window contains a summary list box showing: Non-Compliance,
Graduated Sanction, and Date Imposed. Select a graduated sanction record in the list box, and the
details for that record appear in the fields at the bottom section of the window. Use the fields in
the window to add, modify, or delete graduated sanctions.

Saving a Graduated Sanction record creates an entry in the Case Notes Log that
shows: Date Imposed, Contact Type, Sanction Type, Imposed By, Staff, and
Notes. The information can be viewed from the Case Notes window.

Graduated Sanctions window

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the window, and enter
another graduated sanction.
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Chapter 9: Community Corrections Placement Module
This chapter contains information about the Community Corrections Placement module.
Community Corrections Placement is used to set up a placement for an offender that is to be
supervised by Community Corrections. As you work through the Community Corrections
Placement sub-modules, any information entered is associated with the placement selected in the
Placement tab. Community Corrections Placement contains the following sub-modules:

• Placement
• Program Requirements
• Community Service
• Conditions
• Payment Obligations
• Court Dates
• Attorney
• Charges
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Placement

The Placement sub-module captures and displays offender placement information. The sub-
module contains three tabs: Placement, Status/Closure, and Disposition/Sentence. The
information in the remaining sub-modules relate to the placement selected in the Placement tab.
Before continuing to the other sub-modules in Community Corrections Placement, be sure to
select the appropriate placement from the summary list box.

Placement Tab
The Placement tab contains a summary list box showing: Referral Date, PCC, Court, and Current
Status. An offender can have multiple placements, which appear on separate lines and are
separate records in the list box. Select a placement record in the list box, and the details for that
record appear in the fields at the bottom section of this tab, and on the Status/Closure and
Disposition/Sentence tabs. Use the fields in this tab to add, modify, or delete (with limitations,
see Appendix A: Deleting a Case, Placement, and/or Screening on page A-1) community
corrections placement information.

All Active, Inactive, and Pending Community Corrections placements for an
offender must be assigned to the same case manager. Therefore, if an offender
has existing Active, Inactive, or Pending Community Corrections placements
assigned to one case manager, and a new placement is added and assigned to a
different case manager, the new case manager inherits all existing Active,
Inactive, or Pending placements.

Placement tab
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Placement, continued

Enter the date the placement was sentenced to Community Corrections in the Referral Date data
field. Select the judge that referred the placement from the Referring Judge drop-down list. If the
judge was a substitute, select Substitute from the Referring Judge drop-down list, and type the
substitute’s name in the Referring Subst. Judge data field.

Make a selection from the Supervision Level drop-down list, if appropriate. Select Monitor Only
for placements that do not require traditional supervision, but do need to be monitored to ensure
they complete their Community Service requirement and/or Payment Obligations. If this
placement is a reinstatement, click the Reinstatement check box, and enter the original placement
number that is associated with this reinstatement. This does not link the two placements in any
way, but shows the placement associated with the reinstatement.

!!! Placements checked Monitored Only will not be included in Sections I and III of
the Community Corrections Monthly Report.

Click the New icon to clear the data fields on all placement tabs and enter another placement.
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Placement, continued
Status/Closure Tab
The Status/Closure tab captures and displays placement status and closure information, as well
as information about the placement’s transfer status. When the current status of a placement
changes, PTCC makes an entry showing: Status, Status Date, and Inactive Reason in the
Placement Status History window, which can be accessed by clicking the Status History button.

See page 9-6 for detailed information about business rules associated with this
tab.

Status/Closure tab

If a placement was received from another locality, go to the Transfer In group and select the
locality from the From field drop-down list, and the transfer date from the Date Received drop-
down calendar. Upon returning the placement back to the original locality, select the Date Sent
Back from the drop-down calendar, and select Transferred in-Sent Back as the closure type to
close the placement.
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Placement, continued

If transferring a placement to another locality, go to the Transfer Out group and select the locality
from the To drop-down list and the transfer date from the Date Sent Out drop-down calendar.
Change the Current Status to Inactive, the reason to Transferred Out, and select the Status Date
from the drop-down calendar. Upon receiving the placement back, go to the Transfer Out group
and select the date from the Date Returned drop-down calendar, and update the Current Status
and Status Date, accordingly.

Note: If there is more than one active or inactive placement for the offender, all placements are
automatically transferred out to the same locality using the information entered on this tab
(Transferred Out To, Date Sent Back, Status, Status Date, and Reason Inactive). These
placements can be returned on a one-by-one basis for closure. If any are returned to Active or
Inactive status, the system automatically returns all of them to Active or Inactive status using the
information entered on this tab (Transferred Out, Date Returned, Status, Status Date, and Reason
Inactive).

Only users with Supervisor rights in PTCC can enter Closed Review Date.

Click the New icon to clear the data fields on all placement tabs and enter another placement.

Placement Status History Window
Click the Status History button at the bottom section of the Status/Closure tab to access the
Placement Status History window. The Placement Status History window shows: Status, Status
Date, and Inactive Reason for the currently selected placement. The window provides a quick
overview of the placement’s status history, for instance you can see when and why the status
changed from active to inactive. Information in this window is view only; it cannot be added,
modified, or deleted.

Placement Status History window
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Placement, continued
Community Corrections Placement Rules
The following rules apply to Community Corrections Placements:

Pending Rules
• Placements that leave Pending status can never return to Pending status.
• A Pending-Close closure type only applies when Current Status is Pending, and is the only

way to close a Pending placement.
• You may enter the following information about a Pending placement:
- Program Requirements
- Community Service
- Conditions
- Payment Obligations
- Court Dates
- Attorney
- Charges
- Co-Defendants
- Victims
- Setup information
- Pending Charges
- Outstanding Warrants
- Prior Criminal Activity

• No supervision activity can be entered in the CC Supervision module while a placement has a
status of Pending.
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Placement, continued
Status Rules
• A new Status Date is required whenever Current Status changes.
• The new Status Date must be greater than the current Status Date.
• If Current Status changes from active to inactive for one placement, ALL placements for the

offender that are NOT closed or pending become inactive with the same Reason and Status
Date; however, no new Status Date can be less than any other placement’s current Status
Date. (See Example 1.)

• If Current Status changes from inactive to active, ALL placements for that offender that are
NOT closed or pending become active with the same Status Date; however, no new Status
Date can be less than any other placement’s current Status Date. (See Example 2.)

Example 1: Placement 1 Active 10/05/01
Placement 2 Active 10/20/01

Placement 1 cannot be made inactive on 10/12/01; the date must be greater than
10/20/01.

Example 2: Placement 1 Inactive 10/05/02
Placement 2 Inactive 10/05/02

A new active placement cannot be opened before 10/06/02; and neither existing
placement can be changed to have an active date before 10/06/02.

Closure Rules
• Once a placement is closed, changes to any of the placement information cannot be made

(this includes changing other sub-modules in the Placement module).

Transfer In Rules
• Entering information in the Transfer-In group From field requires information to be entered in

the Date Received field, and vice-versa.
• Use the Transfer In–Date Sent Back closure type only when the placement type is Transferred

In (this is the only way to close a Transferred In placement).
• To close a Transfer In, you must enter the Date Sent Back.
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Placement, continued
Transfer Out Rules
• Entering information in the Transfer-Out group To field requires information to be entered in

Date Sent Out, and vice versa.
• When placements are transferred out, you must make the status Inactive with an Inactive

Reason of Transferred Out.
• When placements are transferred out, all other active and inactive placements will

automatically be transferred out with the same information; however, you can return and
close Transferred Out placements on a one-by-one basis.

• If a Transferred Out placement is made active, enter information in the Transfer-Out group
Date Returned field, and all inactive placements automatically become active again with the
same Date Returned.

• Before closing a Transferred Out placement, you must enter information in the Transfer-Out
group Date Returned field.
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Placement, continued
Disposition/Sentence Tab
The Disposition/Sentence tab captures and displays charge disposition and sentence information
for the selected placement.

Disposition/Sentence tab

Click the New icon to clear the data fields on all placement tabs and enter another placement.
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Program Requirements

The Program Requirements sub-module captures and displays court-ordered requirements
information. The sub-module consists of one tab, Program Requirements. The tab shows: Length
of Supervision, Community Service, Worked to Date, Payment Obligations, and Paid to Date. Each
placement has only one program requirements record.

Program Requirements information should be entered for all placements.

Before setting up Community Service work sites and site assignments, fill out
how many hours of community service the court imposed.

Before setting up Payment Obligations, fill out the amount of Court Costs, Court
Fines, Restitution, and/or Supervision Fees the court imposed.

Program Requirements tab

If Community Service hours are adjusted for any reason, such as additional hours due to a
graduated sanction, you must enter the adjustment + or – here.

As hours are worked and recorded, the system automatically updates the Hours field in the
Worked to Date group.

As payments are made and recorded, the system automatically updates the Court Costs, Court
Fines, Restitution, and Supervision Fees fields in the Paid to Date group.
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Community Service

The Community Service sub-module captures and displays information about the work sites
where the offender will perform community service for the placement selected on the Placement
tab. The sub-module consists of one tab, Community Service. The tab contains a summary list
box showing: Work Site, Locality, and Begin Date. Select a work site record in the list box, and
the details for that record appear in the fields at the bottom section of the tab. Use the fields in
this tab to add, modify, or delete community service information.

Once hours are worked and recorded in the CC Supervision module, the system
calculates and shows: Worked to Date, Amount Remaining, and Last Date
Worked in the Summary of Hours group. This summary is for the total hours
worked, regardless of the number of different work sites.

Before setting up Community Service work sites and site assignments, enter the
number of community service hours the court imposed on the Program
Requirements tab.

Community Service tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
community service work site.
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Conditions

The Conditions sub-module displays the standard State Condition of Supervision, and allows the
additional of Additional Conditions (locally defined), and/or Other Conditions (unique
conditions) for the offender. The sub-module contains one tab, Conditions. The tab contains a
summary list box showing either the State Conditions or Additional Conditions, depending on the
radio button selected in the Conditions to View group. Conditions entered in this tab are for the
placement selected in the Placement tab.

State Conditions are automatically entered for the offender; they cannot be
modified. Once entered, Additional Conditions can be added or removed, and
Other Conditions can be added, modified, or deleted.

Conditions tab

Select the date the Conditions take effect from the Date drop-down calendar. Select Yes or No
from the Agreement Signed drop-down list to indicate whether the offender signed the
Conditions of Supervision form.
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Conditions, continued
Adding Additional Conditions
Follow the steps in the procedure below to select additional conditions.

1. Select the Additional radio button in the Conditions to View group, and click the Ellipse
button.

Result: The Additional Conditions window appears with Additional conditions on the left.

Additional Conditions window

2. Highlight the Additional Condition to be imposed, click the Add button, and the Additional
condition moves to the list box on the right.

There is no limit to the number of Additional Conditions that can be entered.

3. Click the OK button and the condition appears in the Conditions tab.
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Conditions, continued
Removing Additional Conditions
To remove Additional Conditions:
• select the condition to be removed on the right
• click the Remove button, and the condition moves back to the list box on the left.

Entering Other Conditions
Follow the steps in the procedure below to select Other conditions.

1. Type the unique condition in the Other Conditions memo box on the Conditions tab.

Other Conditions memo box

2. Click Save.

Removing Other Conditions
To remove Other Conditions:
• select the condition to be removed in the Other Conditions memo box, and
• press the Delete key on the keyboard.
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Payment Obligations

The Payment Obligations sub-module captures and displays information about an offender’s
payment obligations for the placement selected in the Placement tab. The sub-module consists of
one tab, Payment Obligations. The tab contains a summary list box showing: Obligation, Date
Imposed, Final Amount Due, and Balance Remaining. Select a payment obligation record in the
list box, and the details for that record appear in the fields at the bottom section of the tab. Use
the fields in this tab to add, modify, or delete payment obligations.

As payments are entered in the Supervision module, the system automatically
updates the following data fields in the Payment Obligations tab:
• Final Amount Due
• Last Payment
• Amount Paid To Date
• Balance Due

Before setting up Payment Obligations, enter the amount of Court Costs, Court
Fines, Restitution, and/or Supervision Fees the court imposed on the Program
Requirements tab.

Payment Obligations tab
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Payment Obligations, continued

If an offender’s payment obligation amount is not defined, click the Undefined check box. Select
Court Clerk, Program, or Victim from the Remit To drop-down list, depending on who will receive
the payments. Type any adjustments to Payment Obligations in the Adjustment data field, and
type the reason for the adjustment, such as Court Order, in the Reason data field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
payment obligation.

If an offender is going to work extra Community Service hours in lieu of a
payment, select the Payment Obligation, enter a negative payment adjustment,
and enter the reason as Community Service in Lieu of. Make sure you add the
hours to the Program Requirements and Community Service tabs.
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Court Dates

The Court Dates sub-module captures and displays information about future Court Dates for the
placement selected in the Placement tab. The sub-module consists of one tab, Court Dates. The
tab contains a summary list box showing: Court, Court Date, and Hearing Type. Select a court
date record in the list box, and the details for that record appear in the fields at the bottom section
of the tab. Use the fields in this tab to add, modify, or delete court dates.

Court Dates tab

If the court requires the case manager to appear in court with the offender for any reason, select
the Case Manager needed in Court w/ Offender check box. If the judge is a substitute, select
Substitute from the Judge drop-down list, and type the substitute’s name in the Substitute Judge
data field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
court date.
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Attorney

The Attorney sub-module captures and displays attorney information for the placement selected
on the Placement tab. The sub-module consists of one tab, Attorney. The tab contains a summary
list box showing: Attorney Name, Attorney Type, and Start Date. Select an attorney record in the
list box, and the details for that record appear in the fields at the bottom section of the tab. Use
the fields in this tab to add, modify, or delete attorney information.

Attorney tab

Click the New icon to clear the data fields at the bottom section the tab and enter another
attorney.
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Charges

The Charges sub-module captures and displays a variety of information relating to an offender’s
charges. The sub-module contains four tabs: Existing Charges, New Charges, Co-Defendants, and
Victims. Assign charges to a placement in either the Existing Charges or New Charges tabs. You
cannot assign both Existing Charges and New Charges to the same placement.

Existing Charges Tab
The Existing Charges tab allows charges to be assigned to a placement that were entered in
Screening and marked Referred to CC. The Existing Charges tab has two summary list boxes,
Assigned Charges and Unassigned Charges. The list boxes show: Arrest Date, Primary Offense,
Current Category, Current Descriptor, Current CC, Orig. Category, Orig. Descriptor, and Orig. CC.
Select a charge record in either of the list boxes, and the details for that record appear in the
fields at the bottom section of the tab. Use the Assign Charge to Placement check box in this tab
to assign any of the offender’s unassigned charges to the placement selected on the Placement
tab.

Existing Charges can be assigned to a placement if the charges associated with
the placement were marked as:
• Referred to CC in Screening-Charges Update, or
• Community Supervision Type is Community Corrections on PT Placement

Charges -Amend/Disposition.

Existing Charges tab
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Charges, continued
Assigning Charges
Follow the steps in the procedure below to assign existing charges to a placement.

1. Select the charge from the Unassigned Charges list box on the right. Only one charge can be
assigned at a time.

2. Click the Assign Charge to Placement check box.

3. Save the record.

Result: When the record saves, the charge moves to the Assigned Charges list box.

Existing Charges cannot be modified from the Charges sub-module. To make a
change: unassign the charge, return to Charge Update in Screening, make the
change, and return to the Existing Charges tab to reassign the charge.

Unassigning Charges
Follow the steps in the procedure below to unassign charges:
• Select the charge from the Assigned Charges list box. You can only unassign one charge at a

time.
• De-select the Assign Charge to Placement check box.
• Save the record.

Result: When the record saves, the charge moves back to the Unassigned Charges list
box on the right.
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Charges, continued
New Charges Tab
The New Charges tab allows the entering of charges associated with the placement that were not
previously entered in Screening. The tab contains a summary list box showing: Arrest Date,
Primary Offense, Current Category, Current Descriptor, Current CC, Orig. Category, Orig.
Descriptor, and Orig. CC. Select a charge record in the list box, and the details for that record
appear in the fields at the bottom section of the tab. Use the fields in this tab to add, modify, or
delete new charges.

New Charges tab

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
charge.

Once a charge is saved, you can duplicate charges by selecting a charge, and
clicking Edit>Duplicate Charge on the menu bar. When duplicating a charge, the
system prompts for duplication of the associated co-defendants and victims.

As new charges are entered, one and only one must be marked as the Primary Offense. If there is
more than one charge, the Primary Offense is the charge that is considered the most serious,
based on the potential maximum penalty of each charge.
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Charges, continued
Co-Defendants Tab
The Co-Defendants tab captures and displays information about co-defendants for the charge
selected in the Existing Charges or New Charges tab for a particular placement. The tab contains
a summary list box showing: Name and Relationship. Select a co-defendant record in the list box,
and the details for that record appear in the data fields at the bottom section of the tab. Use the
fields in this tab to add, modify, or delete co-defendants.

Co-Defendants tab

To add or view a co-defendant for another charge:
• go back to the Existing Charges or New Charges tab
• select the charge, and
• return to this tab.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another co-
defendant.
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Charges, continued
Victims Tab
The Victims tab captures and displays information about victims for the charge selected in the
Existing Charges or New Charges tab for a particular placement. The tab contains a summary list
box showing: Name, Relationship, and Notification. Select a victim record in the list box, and the
details for that record appear in the data fields at the bottom section of the tab. Use the fields in
this tab to add, modify, or delete victims.

Victims Tab

To add or view a victim for another charge:
• go back to the Existing Charges or New Charges tab
• select the charge, and
• return to this tab.

Type any property damage in the Property Damage data field. Select Death, Emotional, None,
Physical, Serious Physical, or Threatened from the Extent of Injury drop-down list. Select Yes or
No from the Notification Requested data field. Select the date the victim was notified of the
person’s release in the Date Notified field.

Click the New icon to clear the data fields at the bottom section of the tab, and enter another
victim.
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Chapter 10: Community Corrections Supervision Module
This chapter contains information about the Community Corrections Supervision module, which
captures and displays all supervision-related information for offenders. Community Corrections
Supervision contains the following sub-modules:

• Schedule
• Case Notes
• Referrals
• UDS
• Payment Obligations
• Non-Compliance
• Community Service

Community Corrections Supervision window



PTCC User Guide

PTCC Case Management System10-2

Schedule

The Schedule sub-module shows a calendar of the offender’s scheduled appointments. A Folder
icon on a calendar date indicates an appointment has been scheduled. Click the folder and a list
of activities scheduled for that date appears in the Activities list box at the bottom section of the
window. The Activities list box shows: Date, Type, and Note. You can schedule new
appointments, delete existing appointments, or enter contact notes for a scheduled appointment
from this window. More than one appointment can be made for the same day.

Schedule window

Use the slide bar at the bottom section of the calendar to help select the date.
• Click to the right or left of the slide button to change the year.
• Click the left or right arrow to change the month.
• Click and drag the slide button to get to dates that are more than a few years in the past or

future.

Click the New button to clear the data fields in the tab and enter another appointment.
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Schedule, continued
Entering Schedule Information
To enter offender schedule information:
• click the Quick-Add button to enter recurring appointments, or
• click the New button to enter one appointment at a time.

Viewing Appointment Details
To view the details of an appointment:
• click the Folder icon for the date, and
• double-click the appointment from the Activities list box, or
• select the appointment and click the Detail button at the bottom section of the window.

Deleting Scheduled Appointments
To delete a scheduled appointment:
• click the Folder icon for the date
• select the appointment from the Activities list box, and
• click the Delete button at the bottom section of the window.

Filtering Appointment Types
To filter appointments shown in the Activities list box using a specific Filter option:
• click the Filter drop-down arrow, and
• select a filter from the drop-down list.
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Schedule, continued
Quick Add
Click the Quick Add button, and the New Schedule window appears. This window allows you to
schedule the same appointment type for multiple dates. When entering appointments on this
window, a Folder icon appears on all appropriate dates on the calendar.

New Schedule window

When scheduling appointments using Quick Add, the following information is required:
Appointment Type, Start Date, Frequency, and Occurrences. If you schedule an appointment to
occur on the 1st, 2nd, etc. week of the month, Day is also required.

Example 1: This shows how to schedule a recurring weekly appointment for six weeks. Follow
the steps in the procedure:
 
1. Enter the information in the New Schedule window as follows:

New Schedule window
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Schedule, continued

2. Click the OK button.

Result: A Folder icon for an Office Visit appears on every Wednesday for six weeks from
the date of the first appointment.

Schedule window

3. Click on the Folder icon and the appointment Date, Type, and Note appears in the Activities
list box at the bottom section of the window.

Example 2: This shows how to schedule an appointment for the first Tuesday of each month for
six months, starting June 4th. Follow the steps in the procedure below:

1. Enter the information in the New Schedule window as follows:

New Schedule window
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Schedule, continued

2. Click the OK button.

Result: A Folder icon for an Office Visit appears on the first Tuesday of the next six
months from the date of the first appointment.

Schedule window

3. Click on the Folder icon and the appointment Date, Type, and Note appears in the Activities
list box at the bottom section of the window.
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Schedule, continued
New
To add a new appointment or contact note, click the New button and the Schedule Detail window
appears. The window serves two purposes as follows:
• schedule an appointment in the top of the window, or
• enter a Contact Note about a scheduled appointment in the bottom section of the window.

A Contact Note cannot be entered here unless an appointment was scheduled.

Not all Contact Notes can be entered from here. Referrals, UDS, Payments, Non-
Compliance, and Graduated Sanctions must be entered through their respective
sub-module in the PT Supervision module.

Saving a Contact Note record creates an entry in the Case Notes Log that shows:
Contact Date, Contact Type, Time, Defendant Present, and Contact Note. The
information can be viewed from the Case Notes window. Once a Contact Note
has been entered and saved, it cannot be changed or deleted.

Schedule Detail window

If the offender was present for the contact, click the Defendant Present check box.
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Case Notes

The Case Notes sub-module serves two functions, it allows for the:
• entering of a New Note for an offender, or
• displaying of View Notes for an offender.

New Note
Click the New Note radio button to enter a case note about an offender for a specific date.

Case Notes window

Select the note type from the Type drop-down list, select the date, and type in the time. If the
offender was present for the contact, click the w/Defendant check box.

Type the note in the Notes field, and click the Save button. Once the note is saved, it cannot be
modified or deleted. A new note, however, can be entered.
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Case Notes, continued
View Notes
Click the View Notes radio button to view notes about an offender over a specified period of
time.

Case Notes window

To filter the case notes by a specific type and/or date range, select the note type from the Type
drop-down list and/or select Date Start and Date End, and click the Run button. If no filtering
information is entered, all case notes will appear on the log.

Result: All case notes, based on the criteria selected, appear in a report called Case Notes
Log. To print the report, click the Print icon at the top of the report window.

Case Notes Log

See Chapter 11: Reports and Forms for more information about other reports.
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Referrals

The Referrals sub-module captures and displays information needed to refer an offender to an
education or treatment program, as well as to record the first substance abuse testing and first
community service assignment. The sub-module contains a summary list box showing: Referral,
Referral Date, and End Date. Select a referral record in the list box, and the details for that record
appear in the fields at the bottom section of the window. Use the fields in this sub-module to add,
modify, or delete referrals.

!!!

Referral information is part of the Community Corrections Monthly Report,
therefore, all referrals must be entered.

The Date First Attended field must be completed for the New Service Placement
to be counted on the Community Corrections Monthly Report.

An offender’s first drug test and first community service assignment are
considered Referrals, and must be entered here to receive credit on the
Community Corrections Monthly Report.

Saving a Referral record creates an entry in the Case Notes Log that shows:
Referral Date, Contact Type, Referral Type, Where, Date First Attended, Staff,
and Outcome. The information can be viewed from the Case Notes window.

Referrals window

Date First Attended and End Date are required when the Outcome for the referral is Successful.
Date First Attended and Outcome are required when an End Date is entered. If the referral is a
result of a graduated sanction due to a non-compliance issue, select the Graduated Sanction
check box. If this referral was initiated in Pretrial and then transferred to Community
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Referrals, continued

Corrections, select the Transferred from Pretrial check box. Select Insurance, Program, Other, or
Self from the Who Pays drop-down list to identify who is responsible for paying for the service.
Select Court Ordered, Employment Directed, Other, or Voluntarily from the Entered drop-down
list to identify how the person entered the education or treatment program.

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the tab, and enter another
referral.
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UDS

The UDS (Urine Drug Screen) sub-module allows you to capture and view information about
drug tests performed for the offender. The sub-module contains two tabs: Test Information and
Test Results. The window contains a summary list box showing: Collected, Result Date, Result,
and Test Type. Select a UDS record in the list box, and the details for that record appear in the
fields in the fields at the bottom section of the tabs. Use the fields in the tabs to add, modify, or
delete UDS information.

Test Information Tab
The Test Information tab allows the capturing and viewing of information about the collection
and testing of UDS’. Information in this tab must be saved before continuing to the Test Results
tab. Date of Results must be entered for the test results to appear in the Results column of the
summary list box. If data is only entered in the Test Information tab, a case note is not added to
the Case Notes Log.

Test Information tab

Select the staff person who collected the UDS from the Collected By drop-down list. Type the
name of the technician who tested the sample in the Technician field. Use the Test Location field
to record where the sample was tested. Type the name of the lab that conducted the test in the
Lab field.

Click the New button to clear the data fields on both tabs and enter another UDS.
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UDS, continued
Test Results Tab
The Test Results tab captures and displays the drugs the offender was tested for, and the results
of those tests.

Saving Test Results creates an entry in the Case Notes Log that shows: Date
Collected, Contact Type, Drug Test Type, Drugs Tested, Results, Staff, and
Notes. The information can be viewed from the Case Notes window.

Test Results tab

To select a drug: highlight the drug on the left, click the Add button and the drug appears on the
right.

To remove a drug: highlight the drug on the right, click the Remove button and the drug appears
on the left.

Mark positive results by clicking the check box next to the drug.

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields on both tabs and enter another UDS.
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Payment Obligations

The Payment Obligations sub-module captures and displays information about payments made
by the offender. The sub-module contains a summary list box showing: Placement, Status,
Status Date, and Referral Date. Select a placement record from the list box, and the payment
obligations for that placement appear in the Obligations list box. If payments have been made for
a particular obligation, a + sign appears next to the obligation. Click the + sign and the payments
made toward that obligation appear in the Obligations list box.. Highlight a specific payment to
modify or delete it. Add new payments by selecting a placement, selecting an obligation,
entering the amount and the date, and clicking the Save icon.

Only Active and Inactive placements appear on the CC Supervision Payment
Obligation window.

The actual Payment Obligation must be entered in CC Placement module
Payment Obligations sub-module in order to appear here.

Payment information is part of the Community Corrections Monthly Report, and
therefore all payments must be entered.

Saving a Payment record creates an entry in the Case Notes Log that shows:
Arrest Date and Referral Date for the placement, plus Contact Type, Date Paid,
Amount Paid, Balance Due, Staff, and Notes. The information can be viewed
from the Case Notes window.

Payment Obligations window

The Amount Paid field is limited to less than $1,000. If the payment made is greater than or equal
to $1,000, enter the payment as two separate payments. The Payment No field will automatically
fill once a payment has been entered and saved. If there is a receipt number, enter it in the
Receipt No field. If information is entered in the Note field and the Save button is clicked, the
note cannot be modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields on the right side of the tab, and enter additional
payments made.
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Non-Compliance

The Non-Compliance sub-module captures and displays information about an offender’s non-
compliance issues. The sub-module contains a summary list box showing: Non-Compliance Type,
Date, and Action Taken. Select a non-compliance issue record in the list box, and the details for
that record appear in the fields at the bottom section of the sub-module. Use the fields in this
sub-module to add, modify, or delete non-compliance issues.

Saving a Non-Compliance record creates an entry in the Case Notes Log that
shows: Non-Compliance Date, Contact Type, Non-Compliance Type, Action,
Staff, and Notes. The information can be viewed from the Case Notes window.

Non-Compliance window

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the tab, and enter another
non-compliance.

Graduated Sanctions Button
The Graduated Sanctions button allows access to the Graduated Sanctions window, which
captures and displays graduated sanction information imposed against an offender. If the non-
compliance issue results in Graduated Sanctions being imposed:
• select the Graduated Sanction Imposed check box
• save the non-compliance record, and
• click the Graduated Sanctions button to activate the Graduated Sanctions window.
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Non-Compliance, continued
Graduated Sanctions Window
The Graduated Sanctions window captures and displays information about graduated sanctions
imposed for the offender. The window contains a summary list box showing: Non-Compliance,
Graduated Sanction, and Date Imposed. Select a graduated sanction record in the list box, and the
details for that record appear in the fields at the bottom section of the window. Use the fields in
the window to add, modify, or delete graduated sanctions.

Saving a Graduated Sanction record creates an entry in the Case Notes Log that
shows: Date Imposed, Contact Type, Sanction Type, Imposed By, Staff, and
Notes. The information can be viewed from the Case Notes window.

Graduated Sanctions window

If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields at the bottom section of the window, and enter
another graduated sanction.
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Community Service

The Community Service sub-module captures and displays information about community service
hours the offender works. The sub-module contains a summary list box showing: Placement,
Status, Status Date, and Referral Date. Select a placement record from the list box, and the work
sites where the work is to be performed appear in the work site list box. If hours have been
worked at a particular work site, a + sign appears next to the work site. Click the + sign, and the
hours worked at that site appear. Highlight a specific record of hours worked to modify or delete
it. Add new hours by selecting a Placement, selecting a work site, entering the date and hours
worked, and clicking the Save icon.

Only Active and Inactive placements appear in the CC Supervision Community
Service sub-module.

The actual Community Service obligation and work-site must be entered in CC
Placement module, Community Service sub-module to appear here.

Community Service hours are part of the Community Corrections Monthly
Report, and therefore all hours must be entered.

Saving a Community Service record creates an entry in the Case Notes Log that
shows: Placement No., Contact Type, Work Site, Work Type, Locality, No. of
Hours to Complete, No. of Hours Worked, Staff, and Notes. The information can
be viewed from the Case Notes window.

Community Service window

The Hours Worked field is limited to less than 1,000 hours. If the hours worked are greater than
or equal to 1,000, the hours will need to be entered as two separate entries.

 If information is entered in the Note field and the Save button is clicked, the note cannot be
modified or deleted. A new note, however, can be entered.

Click the New button to clear the data fields on the right side of the tab, and enter additional
hours worked.
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Chapter 11: Reports and Forms
This chapter contains information about reports and forms. PTCC contains 15 reports and 21
forms. The chapter includes information about accessing, running, and printing reports and
forms.

The Report window default view shows All reports and forms. Select the
Reports or Forms radio button to view those specific items.

See Appendix B: Sample Reports and Forms for printed examples of the
reports and forms.

Accessing Reports and Forms

Follow the steps in the procedure below to access Reports:

1. click the Reports icon, or

2. click Reports>Run Reports from the menu bar.

Result: The Reports module opens showing All reports and forms.

Reports window
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Accessing Reports and Forms, continued

3. Select the desired report or form by either:
• double-clicking the name, or
• selecting the name and clicking the Run button.

Viewing Reports and Forms

After selecting a report or form, a parameter box appears prompting you to enter the information
needed to produce a specific report or form.

Conditions of Supervision parameter box

The sample shown above has three fields: Program Type, Case ID, and Placement.

Select the Program Name (Pretrial or Community Corrections) from the drop-down list.

Type the case identification number directly into the Case ID field, or click the Magnifying Glass
icon at the end of the field to search for the case. For more information about searching for case
identification, see Searching for a Case on page 3-5.

Type the placement number directly into the Placement field, or click the Magnifying Glass icon
at the end of the field to gain access to the Placement Search window.

Placement Search window
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Viewing Reports and Forms, continued

The Placement Search window allows querying of the database using the currently selected case
identification number. The search window contains a Placements list box showing: Placement
ID, Program Type, Current Status, Status Date, Referral Date, and Locality. Select the
placement to be included by double clicking the line, or selecting the line and clicking the Open
button.

When you complete the required fields in the parameter box, click OK.

Result: The form appears in a Print Preview window.

Conditions of Supervision form

The Print Preview window contains a menu bar that allows you to change pages, print the report,
export the report, and change the viewing size. It also displays the page, percentage, and total
number of pages.
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Viewing Reports and Forms, continued
Printing Reports and Forms
Once the report or form has been selected and run, follow the steps in the procedure below to
print it:

1. Click the Print icon.

Result: The Print window appears.

2. Select the number of pages and copies desired (for only one copy of the report or form, do
not change anything).

3. Click the OK button.

4. The report prints to the default printer.

Exporting a Report or Form
An electronic copy of a report or form can be exported in several different formats. Follow the
steps in the procedure below to save an electronic copy of a report or form:

1. Click the Export icon on the Print Preview tool bar.

Result: The Export window appears.

Export window

2. Select the desired format from the Format drop-down list.

3. Select Disk File from the Destination drop-down list.



Chapter 11-Reports and Forms

October 2002 Virginia Department of Criminal Justice Services 11-5

Viewing Reports and Forms, continued

4. Click the OK button.

Result: The Choose Export File window appears, prompting you to designate where to
save the file.

Choose Export File window

5. Select where to save the report or form, and click the Save button.

Do not save the report or form in the default folder. That folder is on the server,
and not on your PC. To save the report on your PC, click the drop-down arrow,
select the C:-drive, and then choose the desktop or a folder in which to save the
report or form.
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Creating Reports and Forms

This section provides short descriptions of each report and form, and explains how to create
them.

See Appendix B: Sample Reports and Forms for samples of all reports and
forms.

Reports
Following is a list of all PTCC reports in alphabetical order. Creating reports is a two-step
procedure:
• fill the fields in the parameters window, and
• click the OK button.

Appointment Calendar
The Appointment Calendar Report shows a list of scheduled appointments for all cases or for a
specific case manager’s case. The results are sorted by: Date, Name, and Appointment Type. The
content of the report can be altered by using the following criteria: Program Type, Start Date, End
Date, Case Manager, and Appointment Type.

Appointment Calendar Report

Basic Demographic Information
The Basic Demographic Information report shows demographic information (basic demographics,
aliases, residence, etc.) about a specific case. Select Program Type from the drop-down list and
use the current case, or use the Magnifying Glass icon in the Case ID field to select a different
case.

Basic Demographic Information
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Creating Reports and Forms, continued
Community Service Log
The Community Service Log returns a record of community service hours logged for all cases, or
for a particular case. The results are sorted by: Name, Placement Number, Work Site, and Date
Worked. The content of the log can be altered by using the following criteria: Case Manager,
Start Date, End Date, Work Locality, Work Site, and Case ID.

Community Service Log

Court Dates Report
The Court Dates Report returns a record of court dates for all cases. The results are sorted by:
Court Date, Name, Court, and Hearing Type. The content of the report can be altered by using the
following criteria: Program Type, Start Date, End Date, and Case Manager.

Court Dates Report
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Creating Reports and Forms, continued
Demographic Statistics
The Demographics Statistics Report returns statistical information about the Pretrial or
Community Corrections population. In addition to showing demographic breakdowns, this report
also captures statistical information about the primary charge for every placement included in the
report. The content of the report can be altered by using the following criteria: Program Type,
Case Manager, Start Date, End Date, and Status.

Demographics Statistics

Drug Testing Log
The Drug Testing Log returns a record of drug tests performed on all cases, or for a particular
case. The results are sorted by: Name, Test Date, and Drugs Tested. The content of the log can be
altered by using the following criteria: Program Type, Start Date, End Date, Case Manager,
Results, Drug Tested, and Case ID.

Drug Testing Log



Chapter 11-Reports and Forms

October 2002 Virginia Department of Criminal Justice Services 11-9

Creating Reports and Forms, continued
Graduated Sanctions Log
The Graduated Sanctions Log returns a record of graduated sanctions imposed on all cases, or for
a particular case. The results are sorted by: Name, Date Imposed, and Sanction Type. The content
of the log can be altered by using the following criteria: Program Type, Start Date, End Date,
Sanction Type, Notes, Imposed By, and Case ID.

Graduated Sanctions Log

Monthly Report CC
The Community Corrections Monthly Report is required by the Virginia Department of Criminal
Justice Services (DCJS). The content of the report can be altered by using the following criteria:
Month and Year. Input the Grant Number for it to appear on the report.

Monthly Report CC

The previous month’s report cannot be printed until the Monday following the
12th of the current month. Older reports can be printed any time.
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Creating Reports and Forms, continued
Monthly Report PT
The Pretrial Services Monthly Report is required by the Virginia Department of Criminal Justice
Services (DCJS). The content of the report can be altered by using the following criteria: Month
and Year. Input the Grant Number for it to appear on the report.

Monthly Report PT

The previous month’s report cannot be printed until the Monday following the
12th of the current month. Older reports can be printed any time.

Non-Compliance Log
The Non-Compliance Log returns a record of non-compliance issues for all cases, or for a
particular case. The results are sorted by: Name, Non-Compliance Date, Non-Compliance Issue,
and Action Taken. The content of the log can be altered by using the following criteria: Program
Type, Case ID, Start Date, End Date, Case Manager, Non-Compliance Type, and Action Taken.
Notes can be included by selecting Yes or No from the Show Notes drop-down list.

Non-Compliance Log
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Creating Reports and Forms, continued
Payment Log
The Payment Log returns a record of payments and payment obligations for all cases, or for a
particular case. The results are sorted by: Name, Placement Number, Type of Obligation, and
Payment Date. The content of the log can be altered by using the following criteria: Program
Type, Start Date, End Date, Case ID, Case Manager, and Obligation Type.

Payment Log

Program Referral Log
The Program Referral Log returns a record of program referrals or all cases, or for a particular
case. The results are sorted by: Name, Referral Program, and Date 1st Attended. The content of
the log can be altered by using the following criteria: Program Type, Case ID, Referral Start Date,
Referral End Date, Include, Case Manager, Outcome Type, and Referral Program. A referral log
showing only the results of referrals from graduated sanctions can be obtained by selecting Yes
from the Result Grad Sanctions Only drop-down list.

Program Referral Log
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Creating Reports and Forms, continued
Screening Report
The Screening Report returns a record of screenings for all defendants, or for a particular
defendant. The results are sorted by: Screening Date and Name. The content of the report can be
altered by using the following criteria: Case ID, Screened By, Start Date, End Date, Screening
Outcome, and Reason Screened Out.

Screening Report

Supervision Report
The Supervision Report returns a record of all placements by placement status. The results are
sorted by: Status, Name, and Placement Number. The content of the report can be altered by
using the following criteria: Program Type, Placement Status, Status Start Date, Status End Date,
Case Manager, and Closure Type.

Supervision Report
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Creating Reports and Forms, continued
Supervisor’s Review List Report
The Supervisor’s Review List Report returns a record of cases that need to be reviewed by a
Supervisor. The results are sorted by: Name, Current Status, and Date of Last Review. The
content of the report can be altered by using the following criteria: Program Type, Review Cases
Older Than, and Case Manager.

Supervisor’s Review List Report

Forms
Following is a list of all PTCC forms in alphabetical order. Creating forms is a two-step
procedure:
• fill the fields in the parameters window, and
• click the OK button.

Any parameter that is not entered will result in a blank line being printed on the
form. Those portions of the form can be completed by hand.

Appointment Letter
The Appointment Letter is used to notify a case about a scheduled appointment. The content of
the letter can be altered by using the following criteria: Case ID, Case Manager, RE, Appt Date,
Appt Time, and Program Name.

Appointment Letter
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Creating Reports and Forms, continued
Authorization for Release Form
The Authorization for Release Form is a form to be dated and signed by the case and case
manager. The form authorizes the Pretrial or Community Corrections programs to obtain
information about the individual. The content of the form can be altered by using the following
criteria: Case ID and Program Name.

Authorization for Release Form

Community Service Agreement Letter
The Community Service Agreement Letter is a form letter to the Community Service Agency
outlining the contract the Community Service Program has with your agency. The content of the
letter can be altered by using the following criteria: Program Name, Work-Site, and Date.

Community Service Agreement Letter

Conditions of Supervision
The Conditions of Supervision form is a contract cases sign to indicate they understand the
behavior that is required of them while in the Pretrial or Community Corrections program. The
content of the form can be altered by using the following criteria: Program Name, Case ID, and
Placement.

Conditions of Supervision
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Creating Reports and Forms, continued
Court Appearance/Continuance Reminder Letter
The Court Appearance/Continuance Reminder Letter is a form letter from the case manager that
is used to notify the case of the location, date, and time of their next scheduled court appearance.
The content of the letter can be altered by using the following criteria: Case ID, Referring Court,
Appt. Date, Appt. Time, Program, and Notes.

Court Appearance/Continuance Reminder Letter

Fines & Costs/Restitution/Community Service Ledger
The Fines and Costs/Restitution/Community Service Ledger is a form to be used when a case
owes fines, court costs, restitution, and/or has community service.

Fines & Costs/Restitution/Community Service Ledger

Inactive Status Form
The Inactive Status Form is a form to be used when a case has an interruption of supervision. The
content of the form can be altered by using the following criteria: Program Name, Case ID, and
Placement.

Inactive Status Form
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Creating Reports and Forms, continued
Intake Appointment Letter
The Intake Appointment Letter is a form letter used to notify cases that they have been assigned
to the Pretrial or Community Corrections agency and when they are to appear for intake. The
content of the letter can be altered by using the following criteria: Case ID, Appointment Date,
Appt. Time, and Program Name.

Intake Appointment Letter

Missed Appointment Letter
The Missed Appointment Letter is a form letter used to notify cases that they have missed a
scheduled appointment and are in violation of their supervision agreement. The content of the
letter can be altered by using the following criteria: Case ID, Missed Appointment Date, New
Date, New Time, and Program Name.

Missed Appointment Letter
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Creating Reports and Forms, continued
Payment Obligations and Schedule Letter
The Payment Obligation and Schedule Letter is a form letter used to inform cases of their
payment obligations and the schedule of payments. The content of the letter can be altered by
using the following criteria: Payment Type, Case ID, Interview, and Date.

Payment Obligation and Schedule Letter

Pretrial Authorization Form
The Pretrial Authorization Form is a form to be dated and signed by the case and the case
manager. The form authorizes the Pretrial programs to obtain information about the individual.
The content of the form can be altered by using the following criteria: Case ID, Interview, and
Date.

Pretrial Authorization Form

Program Referral Schedule Letter
The Program Referral Schedule Letter is a form letter used to inform cases that they have been
referred to a service program and when they must attend. The content of the letter can be altered
by using the following criteria: Case ID and Case Manager.

Program Referral Schedule Letter
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Creating Reports and Forms, continued
Progress Report
The Progress Report is used to notify the transferring program about a case’s progress in
meeting the requirements of supervision. The content of the report can be altered by using the
following criteria: Case ID, Placement, Month of Report, and Final Report.

Progress Report window

Request for Capias/Show Cause Letter
The Request for Capias/Show Cause Letter is a form letter to the court notifying them of a case’s
non-compliance, and requesting a show cause or a capias for the case’s return to court. The
content of the letter can be altered by using the following criteria: Court Case Docket Number;
Case ID, Judicial Officer, Referring Court, Date of Capias, Program Type, Show Cause Rule or
Capias, and Non-Compliance Condition.

Request for Capias/Show Cause Letter
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Creating Reports and Forms, continued
Residence and Employment Verification
The Residence and Employment Verification is a form letter used to instruct cases on when and
how they must provide proof of residence and employment. The content of the form can be
altered by using the following criteria: Case ID, Verification within days, Verification Frequency,
Verify By Date, and Verify By Time.

Residence and Employment Verification

Successful Completion Form
The Successful Completion Form is a form letter used to notify the court when a case has
successfully completed a Pretrial or Community Corrections placement. The content of the form
can be altered by using the following criteria: Case ID, Judicial Officer, Referring Court, Court
Case/Docket Number, Referral Date, and Additional Information.

Successful Completion Form
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Creating Reports and Forms, continued
Transfer Request Form
The Transfer Request Form is a form completed by a transferring agency to notify the receiving
agency that a supervision case is being transferred. The content of the form can be altered by
using the following criteria: Receiving Program, Referring Program, and Case ID.

Transfer Request Form

Treatment Agreement
The Treatment Agreement Form is a form letter to be signed by cases indicating their agreement
to participate willingly in specific substance abuse treatment due to a positive drug test result.
The content of the form can be altered by using the following criteria: Case ID and Date.

Treatment Agreement

Violation Notice Letter
The Violation Notice is a form letter used to advise cases that they are in danger of being returned
to court as non-compliant due to their failure to abide by the conditions of supervision. The
content of the letter can be altered by using the following criteria: Case ID and Date Required By.

Violation Notice Letter
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Creating Reports and Forms, continued
Voluntary Admission Form
The Voluntary Admission Form can be used when a case voluntarily admits to drug/alcohol
usage, and/or to voluntarily confirm results of tests. The content of the form can be altered by
using the following criteria: Case ID and Number of Days.

Voluntary Admission Form

Work-Site Referral Form
The Work-Site Referral Form is an agreement between the work site, agency, and case, as well as
the form that allows you to collect hours worked for community service. The content of the form
can be altered by using the following criteria: Program Name and Case ID.

Work-Site Referral Form
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Chapter 12: Administration
PTCC relies on a database with a number of tables containing local program-specific information
and a setting to make the software run efficiently. This appendix contains general information
about the administration segment of PTCC. To access the administrative functions go to the
Administration Menu on the menu bar at the top of the window. If you attempt to open the
support tables while a case is open, the following dialog box appears:

Click the Yes button and continue working with the Administration function.

For the Admin user, the Administration Menu has three selections. For all other users, only one
menu option, Application Settings, is available.

Administration Menu

The following paragraphs describe the contents and provide instruction for use.
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Support Tables

There are 12 locally supported tables that allow you to enter and modify information specific to
your local program. Click Administration>Support Tables… from the drop-down menu. Only
users with Admin rights can modify these tables.

Result: The Support Table Maintenance window appears.

Support Table Maintenance window

Select the table to be worked on from the Support Table list on the left. The table appears in the
work area on the right.
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Support Tables, continued

Make additions to the selected table using the top row; make modifications in the specific row to
be modified. When you finish adding or modifying information, press the Enter key to save the
information.

Work Site table

!!!
Once an item is entered into a table, it cannot be deleted. Be sure you want to
add the item before pressing the Enter key. Some tables allow you to
designate item status as active or inactive. Inactive keeps an item from
appearing in drop-down lists if it is out-dated or unavailable; it does not remove
the item from the table.

Adding Values to the Support Tables
Adding values to the Support Tables for the first time:

Some support tables are installed with pre-set values. Entering the first record into these tables is
done by typing the information into the top row and pressing the Enter key.

Other tables are installed with no pre-set values. These tables will have one record that will say
Enter first (name of support table) value here. For these tables, modify the initial record with
the first record of information by typing over the fields in the highlighted row and pressing the
Enter key (do NOT use the top row). Once the first valid record is entered, type the
information into the top row, and press the Enter key to add additional records.

Adding values to the Support Tables after the first time:

Select the table to add values to, enter the information in the top row, and press the Enter key
to save the information.
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Support Tables, continued
Modifying Values in the Support Tables
To modify existing support table information, open the table containing the information to be
modified, click in the appropriate row, make the necessary changes, and press the Enter key.

If you try to exit the table without saving the new information, the following warning appears:

Data Changed dialog box

Additional Conditions
The Additional Conditions table contains additional conditions that are common to your local
program, and that a judicial officer may choose to impose on a defendant or offender. This table
allows conditions to be entered or modified. The table contains three fields: AddCond_ID,
AddCond_Desc, and AddSequence. The AddCond_ID field is a unique identifier for additional
condition; the AddCond_Desc field contains a written description of the condition, and the
AddSequence field contains the add sequence, or order in which the description appears if the
condition has multiple lines. Additional conditions appear in the Conditions sub-module in
Pretrial and Community Corrections Placement modules, and in the Conditions of Supervision
report. There are no preset entries.

Additional Conditions table

The Additional Conditions table appears in the following modules and sub-
modules:
• PT Placement: Conditions, and
• CC Placement: Conditions.
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Support Tables, continued
Entering Conditions
The very first time a condition is entered in this table, enter it in the highlighted area containing
the text Enter Condition here. Add subsequent conditions in the first blank row at the top of the
table. When you press the Enter key, the conditions appear in the table listed in Add Condition
and Add Sequence order (see Example 1).

Example 1: To enter a short condition that will fit on one line (less than 247 characters):

AddCond_ID AddCond_Desc AddCond_Sequence
1 You must attend Anger Management classes. 1
2 You must follow a 10 p.m. curfew 1

Note: The two conditions above are separate conditions, which can be selected and printed
separately. The AddCond_ID is different for each one.

Entering Conditions with Multiple Lines
If a condition requires more space than 247 characters in the description field, the rest of the
condition can be entered in subsequent lines. If this is done, make sure the AddCond_ID field for
each line contains the same number, and use the AddCond_Sequence field to identify the order in
which each line should be displayed. Leave a space at the beginning of each additional line, so
that the condition displays correctly when the system joins the lines (see Example 2).

Example 2: To enter a long condition that will not fit on one line (more than 247 characters):

AddCond_ID AddCond_Desc AddCond_Sequence
3 You must complete 150 hours of Community Service and 1
3  report your hours on a weekly basis to your Case

Manager.
2

Note: The two lines in the example above contain information needed for one condition. The
AddCond_ID is the same for both lines. The AddCond_Sequence shows the order in which the
lines should be displayed. When printed, Condition 3’s AddCond_Desc prints in the order of the
AddCond_Sequence.
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Support Tables, continued
Address Type
The Address Type table allows you to enter or modify address types. The table contains one
field, AddressType_Desc. The Home, Work, and Other entries are preset.

Address Type table

PTCC does not currently use the Address Type table.

Arresting Agency
The Arresting Agency table allows you to enter or modify local arresting agency information.
The table contains one field, ArrestAgency_Desc. There are no preset entries.

Arresting Agency table

The Arresting Agency table appears in the following modules and sub-modules:
• PT Placement: Placement, and
• CC Placement: Placement.
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Support Tables, continued
Judicial Officer
The Judicial Officer table allows you to enter or modify judicial officer information. The table
contains eight fields: FirstName, MiddleName, LastName, Prefix, Type, Suffix, ModDate, and
CurrentStatus. There are no preset entries.

Prefix-identifies a substitute judge or magistrate, if Substitute is entered; it also
refers to the greetings: Your Honor and The Honorable.
Type-indicates whether the person is a judge or magistrate. The only values
entered here are judge and magistrate.
CurrentStatus-indicates whether the judge or magistrate is active or inactive.

Judicial Officer table

To enter a substitute judge:
• Type Substitute in Prefix column, and
• Type Judge in the Type column.

To enter a substitute magistrate:
• Type Substitute in Prefix column, and
• Type Magistrate in the Type column.

The Judicial Officer table appears in the following modules and sub-modules:
• Screening: Recommendations and Court Update
• PT Placement: Placement and Court Date, and
• CC Placement: Placement and Court Date.
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Support Tables, continued
Local Ordinance
The Local Ordinance table allows you to enter or modify local ordinances. The table contains
three fields: LocOrd_Statute, LocOrd_Descriptor, and ChargeClass. The LocOrd_Statute field
uniquely identifies the ordinance; the LocOrd_Descriptor field contains a description of the
ordinance; and the ChargeClass field contains the charge classification for the ordinance. There
are no preset entries.

Local Ordinance table

PTCC uses the Local Ordinance table in the following modules and sub-modules:
• Screening: Charges and Charge Update
• Setup: Pending Charges, Outstanding Warrants, and Prior Criminal History
• PT Placement: New Charges and Amend/Disposition, and
• CC Placement: New Charges.

Monitor Only Type
The Monitor Only Type table allows you to enter or modify monitor only type information. The
table contains one field, MonitorOnlyType_Desc. There are no pre-set entries.

MonitorOnlyType table

PTCC does not currently use the MonitorOnlyType table. It was setup for a future
enhancement of adding Monitor Only Type to CC Placement.
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Support Tables, continued
Non-Compliance Type
The Non-Compliance Type table allows you to enter or modify types of non-compliance. The
table contains one field, NonCompType_Desc. There are many preset entries.

Non Compliance Type table

The Non-Compliance Type table appears in the following modules and sub-
modules:
• PT Supervision: Non-Compliance, and
• CC Supervision: Non-Compliance.
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Support Tables, continued
Obligation Type
The Obligation Type table allows you to enter or modify types of payment obligations. The table
contains one field, Ob_Desc. The table has four pre-set entries, Supervision Fees, Court Costs,
Court Fines, and Restitution. The entries appear in a predefined order. Any additional entries will
appear under them.

!!!
Although you can move and modify the four pre-set entries, doing so will cause
significant problems with the Community Corrections Monthly Report.

DO NOT CHANGE THE FOUR PRE-SET ENTRIES!

Obligation Type table

The Obligation Type table appears in the following modules and sub-modules:
• PT Placement: Payment Obligations, and
• CC Placement: Payment Obligations.
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Support Tables, continued
Remit To
The Remit To table allows you to enter or modify remit to information. The table contains one
field, RemitTo_Desc. The table has three preset entries: Court Clerk, Program, and Victim.

Remit To table

The Remit To table appears in the following modules and sub-modules:
• PT Placement: Payment Obligations, and
• CC Placement: Payment Obligations.

Supervision Level
The Supervision Level table allows you to enter or modify supervision level information. The
table contains one field, SupLev_Desc. There are no preset values.

Supervision Level table

The Supervision Level table appears in the following modules and sub-modules:
• PT Placement: Placement, and
• CC Placement: Placement.
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Support Tables, continued
Work Site
The Work Site table allows you to enter or modify work site information. The table contains six
fields: WorkSiteName, Addr1, Addr2, City, State, Zip, ContactFirstName, ContactMiddleName,
ContactLastName, ContactSuffix, Phone Number, Staff, Phone Ext., and ModDate. There are no
preset values.

Worksite table

The Work Site table appears in the following module and sub-module: CC
Placement: Placement.
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Support Tables, continued
Work Type
The Work Type table allows you to enter or modify a work type description. The table contains
one field, WorkType_Desc. There are no preset entries.

Work Type table

The Work Type table appears in the following module and sub-module: CC
Placement: Placement.
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Application Settings

This window allows you to change the navigation color.

Application Settings window

1. Click the drop-down arrow, and select the desired color from the drop-down list.

2. Select the Log errors to file check box to create an error file.

The system creates a file called errorlog.log, which it stores at this location:
c:\program files\ptcc\errorlog.log.

This function is not currently enabled in PTCC.

3. Click OK to accept the changes.
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Staff

The Staff menu item provides access to the Staff Maintenance window, which is used to maintain
staff user rights and track staff education and training information.

Staff Maintenance
Use this window to add or update staff information. In addition to the general information at the
top of the window, the staff window has two tabs: System and Courses. Use the System tab to
enter user login information; use the Courses tab to enter course information.

Staff Maintenance window

Staff Number is the number assigned to that person by the administrator. Corr. Signature is the
person’s correspondence signature, which PTCC does not use. Location is the office where the
person works.
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Staff, continued
Staff Maintenance Window Buttons
The Staff Maintenance tab contains four buttons: Lookup, New, Save, and Close.

Lookup
Click the Lookup button to access the Staff Lookup window to search for a current staff member.

Staff Lookup window

Select a current staff member from the list by:
• double-clicking the name, or
• highlighting the name and clicking the OK button.

New
Click the New button to add a new staff member. The cursor appears in the Staff Number field at
the top of the window.

Save
Click the Save button to save added or modified staff information. When adding or modifying
staff member passwords, click the Save button and a system prompt requests verification of the
password.

Close
Click the Close button to return to the blank window in PTCC.



Chapter 12-Administration

October 2002 Virginia Department of Criminal Justice Services 12-17

Staff, continued
System Tab
The System tab allows the addition or modification of user login information.

System tab

Access Level is the group the staff member is assigned to for system permissions. Logon Status
shows if the staff member is currently logged in to PTCC. Logon Last displays the last time and
date the staff member logged on to PTCC. Logoff Last displays the last time and date the staff
member logged off PTCC. PTCC automatically enters Logon Status, Logon Last, and Logoff
Last.
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Staff, continued
Staff Access Levels
The table below shows the different roles and responsibilities associated with PTCC. Each of
these roles can be assigned for PT only, CC only, or for both PT and CC.

Access Level Who they are Permissions
Admin Super Users Can modify all locally defined support tables and the staff

support table. While they can view all other system
information, they cannot add, modify, or delete any
information. They can print reports.

Whether the Admin user is identified as PT, CC, or PTCC
does not make a difference to their access level.

Guest Outside Users Can view all system information, but they cannot add,
modify, or delete any information. They can print reports.

Whether the Guest user is identified as PT, CC, or PTCC
does not make a difference to their access level.

Staff Basic Users Can add, modify, and delete all information about cases
with the following exceptions:
• PT and CC Staff users cannot update Date Last

Reviewed or Closed Review Date
• PT Staff users cannot update CC Placement or CC

Supervision information
• CC Staff users cannot update Screening, PT

Placement, or PT Supervision information
They can print reports.

Supervisor Director, or
Sr. Case
Manager

Can add, modify, and delete all information about cases
with the following exceptions:
• PT Supervisor users cannot modify information in CC

Placement or CC Supervision
• CC Supervisor users cannot modify information in

Screening, PT Placement, or PT Supervision
They can print reports.
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Staff, continued
Courses Tab
The Courses tab allows viewing of a staff member’s education/training history.

Courses tab

A new staff member’s information must be saved, before entering course
information. If the staff record is not saved, the following dialog box:

Click the Ellipses icon to access the Courses window, and add, modify, or delete courses.
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Staff, continued
Courses Window
Staff member Course information can be added, modified, and deleted from this window. The
window contains a summary list box showing: Course Date, Course Title, Hours, Status,
Academic Credit, Degree, Credit Hours, and Cost.

Courses window

Adding a Course
Follow these steps to add a course:
• Type the information in the data fields.
• Click the Save button, and a new line appears in the summary list box.

Modifying a Course
Follow these steps to modify a course:
• Select a line record in the list box, and the details for that record appear in the fields at the

bottom section of the window.
• Change the information in the data fields.
• Click the Save button.
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Appendix A: Deleting a Case, Placement, and/or Screening
This appendix contains information about deleting a case, placement, and/or screening from
PTCC. It includes the conditions that determine whether information cannot be deleted, as well
as the procedures for deleting case information when it is possible to do so.

General

The following paragraphs identify rules about deleting a case, placement, or screening from
PTCC:

A case cannot be deleted if it has:
• a closed placement in Pretrial or Community Corrections, or
• a Pretrial or Community Corrections Placement which at some point had charges associated

with it, even if those charges have been removed.

A Pretrial Placement cannot deleted if it:
• has charges that have been amended or disposed of, or
• is a closed placement.

A Community Corrections Placement cannot be deleted if the placement is closed.

A Screening can always be deleted; however, doing so can be time consuming.

With all deletion processes, PTCC provides error messages identifying associated records that
must be deleted first. Once all associated records are deleted, the main record can be deleted.
Read the error message carefully, go to the sub-module and delete the record, then delete the
information in the sub-module. Deleting the case, placement, or screening is often a multi-step
process.

Follow the steps in the procedures below to delete an entire case, placement, and/or screening.
Begin the process at the last level of information entered. For instance, to delete a Screening for
which information has been entered on the Screening, Charges, Court Assignment, and Court
Report sub-modules, start the deletion process at the Court Report sub-module. If information
also happened to be entered on the Recommendation sub-module, start the deletion process at the
Recommendation sub-module.

Deleting an Entire Case

Follow the steps in the procedure below to delete an entire case:

1. Delete all placements associated with the case (see Deleting an Entire Pretrial or
Community Corrections Placement below).

2. Delete all screenings associated with the case (see Deleting an Entire Screening below).
3. Return to the Setup module, Demographics sub-module, and click the Delete icon to delete

the case.
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Deleting an Entire Pretrial or Community Corrections Placement

Deleting a Pretrial Placement
Follow the steps in the procedure below to delete an entire Pretrial Placement:

1. In the PT Supervision module, Payment Obligations sub-module, highlight the placement to
delete, and delete any payments made for the placement.

2. In the PT Placement module, Placement sub-module, and select the placement to delete.
3. Go to the Payment Obligations sub-module, and delete all payment obligations.
4. Go to the Attorney sub-module, and delete all attorneys.
5. Return to the Placement sub-module, and click the delete icon to delete the highlighted

placement.

Deleting a Community Corrections Placement
Follow the steps in the procedure below to delete an entire Community Corrections Placement:

1. In the CC Supervision module, Payment Obligations sub-module, highlight the placement to
delete, and delete any payments made for the placement.

2. In the CC Supervision module, Community Service sub-module, highlight the placement to
delete, and delete any community service hours entered for the placement.

3. In the CC Placement module, Placement sub-module, select the placement to delete.
4. Go to the Payment Obligations sub-module, and delete all payment obligations.
5. Go to the Community Service sub-module and delete all community service obligations.
6. Go to the Program Requirements sub-module, and delete the program requirements

information.
7. Go to the Attorney sub-module, and delete all attorneys.
8. Return to the Placement sub-module, and click the delete icon to delete the highlighted

placement.

Deleting an Entire Screening

Follow the steps in the procedure below to delete an entire Screening:

1. In the Screening module, Screening sub-module, highlight the screening to delete.
2. Go to the Court Updates sub-module, and remove all updates to the court information

associated with the charges listed.
3. Go to the Charge Updates sub-module, and remove all updates to the charges listed.
4. Go to the Recommendation sub-module, and remove all recommendations for the courts

listed.
5. Go to the Court Reports sub-module, and delete the date created and any report summary

information for the highlighted court, thereby deleting the record of the report being created.
6. Go to the Court Assignment sub-module, and delete all updates to the charges listed (use the

Ctrl key to select multiple charges for deletion).
7. Go to the Original Charges sub-module, and delete all charges listed.
8. Return to the Screening sub-module, and click the delete icon to delete the highlighted

screening.
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Deleting an Entire Screening, continued

At times it may be necessary to delete information from the various sub-modules in a different
order than stated above. For example, if a recommendation was entered for a court that was
updated in the Court Update sub-module, delete the recommendation from the Recommendation
sub-module before deleting the court information from the Court Update sub-module; however, if
no recommendation was made to a court that was updated in the Court Update sub-module, begin
the Screening deletion process at the Court Update sub-module. Again, read the error messages
carefully and they explain what needs to happen during the process.

In several of the Screening sub-modules, because of the application design, the Delete icon does
not function in a normal way. In these sub-modules, clicking the Delete icon removes
information from the record, rather than actually deleting the record. The Delete icon functions
differently when used with the sub-modules listed below:

Court Assignment–the Delete icon removes court assignment information from the charge
highlighted in the Original Court Assignment list box. When the court assignment is
removed, the charge will move back to the Charges list box.

Court Reports–the Delete icon removes the date created and any report summary
information for the highlighted court, thereby deleting the record of the Court Report
being created. The court still appears in the summary list box, but it no longer has an
associated date or summary.

Recommendation–the Delete icon removes the recommendation information that was
entered for the highlighted court appearance. The court still appears record in the list box,
but it no longer has an associated recommendation.

Charge Update–the Delete icon removes any charge update information that might have
been entered about the highlighted charge, and restores the charge to its previous charge
update status or to its original charge status. The charge still appears in the summary list
box, but it no longer has the updated information. If a charge is deleted from the Charge
Update screen that has been Referred to PT or Referred to CC and subsequently assigned
to a placement, it also removes the charge from its PT- or CC-respective assignment.

Court Update–the Delete icon removes any court update information you might have
entered about the highlighted charge, and restores the previous court information for the
charge. The charge still appears in the list box, but it no longer has court update
information.

Multiple Recommendations
If a group of charges have multiple recommendations, delete a Recommendation, then delete its
associated Court Update record, delete the next Recommendation, and then delete its associated
Court Update record. Continue until you remove all Recommendations and Court Updates, and
then continue with the steps above.
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Deleting an Entire Screening, continued
Multiple Charge Updates
If a charge has multiple Charge Updates, delete all updates before deleting the original charge
from the Charges sub-module.

Miscellaneous Error Messages

The following error messages may appear when you attempt to delete a case, placement, and/or
screening.

Original Court Appearance
If, on the Court Update tab, updated court information has either never been entered for the
charge highlighted in the summary list box or updated court information has already been deleted
for that particular charge, and you try to delete the charge, the following message appears:

This message means there is no updated court information to delete from the highlighted charge,
and since only updated court information from the Court Update sub-module can be deleted, not
original court information, there is nothing to delete for this charge in this sub-module. To
continue to delete the screening, continue with the steps listed above. An original court
appearance can only be deleted from the Court Assignment sub-module.

Original Charge
If, on the Charge Update screen, the charge highlighted in the summary list box has either never
been updated or all updated charge information for that particular charge has already been
deleted, and an attempt is made to delete the charge, the following message appears:

This message means there is no updated charge information to delete from the highlighted
charge, and since only updated charge information from the Charge Update sub-module can be
deleted, not an original charge, nothing is left to delete for this charge in this sub-module. To
continue to delete the screening, continue with the steps listed above. An original charge can
only be deleted from the Charges sub-module.



Appendix A-Deleting a Case, Placement, and/or Screening

October 2002 Virginia Department of Criminal Justice Services A-5

Miscellaneous Error Messages, continued
Existing Screenings
It is possible, when trying to delete a case, to get the following error message:

This error message can occur for two reasons:
• A case has screenings that need to be deleted before the case can be deleted.
• A PT or CC placement at some point had charges associated with it (even if those charges

have been removed). When adding charges to a PT or CC placement, PTCC adds an internal
record to the Screening table. Currently, when deleting a PT or CC charge, the application
does not remove the additional Screening record, therefore when it tries to delete the case,
the system thinks there are existing screenings even though there are not. Under these
circumstances, the case cannot be deleted.
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Appendix B: Sample Reports and Forms
This appendix contains examples of the all PTCC reports and forms, in alphabetical order
starting with Reports.

Reports

Appointment Calendar
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Reports, continued
Basic Demographic Information
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Reports, continued
Community Service Log
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Reports, continued
Court Dates
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Reports, continued
Demographic Statistics
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Reports, continued
Drug Testing Log
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Reports, continued
Graduated Sanctions Log
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Reports, continued
Monthly Report CC
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Reports, continued
Monthly Report PT
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Reports, continued
Non-Compliance Log
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Reports, continued
Payment Log
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Reports, continued
Program Referral Log
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Reports, continued
Screening Report
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Reports, continued
Supervision Report
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Reports, continued
Supervisor’s Review List Report
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Forms

Appointment Letter
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Forms, continued
Authorization for Release Form
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Forms, continued
Community Service Agreement Letter
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Forms, continued
Conditions of Supervision
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Forms, continued
Court Appearance/Continuance Reminder Letter
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Forms, continued
Fines & Costs/Restitution/Community Service Ledger
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Forms, continued
Inactive Status Form
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Forms, continued
Intake Appointment Letter
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Forms, continued
Missed Appointment Letter
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Forms, continued
Payment Obligations and Schedule
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Forms, continued
Pretrial Authorization Form
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Forms, continued
Program Referral Schedule Letter
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Forms, continued
Progress Report
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Forms, continued
Request for Capias/Show Cause Letter



PTCC User Guide

PTCC Case Management SystemB-30

Forms, continued
Residence and Employment Verification



Appendix B-Sample Reports and Forms

October 2002 Virginia Department of Criminal Justice Services B-31

Forms, continued
Successful Completion Form
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Forms, continued
Transfer Request Form
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Forms, continued
Treatment Agreement
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Forms, continued
Violation Notice Letter



Appendix B-Sample Reports and Forms

October 2002 Virginia Department of Criminal Justice Services B-35

Forms, continued
Voluntary Admission Form
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Forms, continued
Work-Site Referral Form
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Glossary
The table below contains words and definitions.

Term Definition
Active Case Any defendant or offender being supervised and provided pre- or post-

trial services in accordance with standard supervision requirements,
and who has not been placed on inactive supervision or been removed
from supervision.

Case A defendant or an offender entered into the Pretrial and Community
Corrections Case Management System established by the Virginia
Department of Criminal Justice Services.

Inactive Case A case is considered inactive when supervision has been suspended
for any reason.  These cases have not yet been closed; however,
supervision days are not counted.

Intake A process option in the PTCC Setup Module that is used when
gathering information from defendants or offenders for the purpose of
opening a case for active supervision.  This includes the compilation of
the required case record information and assessment of defendant or
offender needs through an interview.

Interview/Pending A process option in the PTCC Setup Module that is used when
interviewing a defendant in preparation for an investigation or to set up
a placement in advance of an intake.

Investigation A process option in the PTCC Setup Module that allows for a formal
pre- or post-trial procedure that includes preparing a court report
summarizing the results of the intake interview, the defendant’s or
offender’s financial status, social history, community stability, verified
criminal history, and DMV record.

Monitoring
Placement

For pretrial this is a Court approved process of notifying, by phone or
mail, defendants released by the magistrate on summons, promise to
appear, or unsecured bond, of the first and future court appearances.
For post-trial this a service provided to the court that tracks an
offender’s compliance with a court order for performing community
service only or in lieu of fines and costs, which does not require
probation supervision.  Offenders in this status are not subject to
standard supervision requirements nor counted as a placement.

New Case Any defendant or offender entered into PTCC for the first time and no
other information exists on PTCC.

Pending
Placement

A court referral where supervision services by either a Pretrial or
Community Corrections program has not started.  For Pretrial
Services, an example could be when a defendant must post bond
before being released to Pretrial Services.

Placement An action by a judicial officer as a result of a bail determination or by
court order requiring a defendant or an offender to be supervised by
an agency for one or more offenses or charges.

Primary Charge
Classification

The charge that is the most severe, as defined by range of sentence
and offense type.
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Glossary, continued

Term Definition
Reinstatement A placement that was previously closed unsuccessful that the Court

has referred back (reinstated) to the program for the charges in the
original placement.

Screening The process of determining the number of detained defendants
awaiting initial or subsequent bail hearing available for pretrial
investigation.
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